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Introduction

Maplytics™ is a leading Certified for Microsoft Dynamics 365 (CfMD) geo-analytical mapping app.
Maplytics empowers users across verticals with the power of Geographical Data Visualization, Optimized
Routing, Automated Appointment Planning, Proximity Search, Heat Maps, Shape Overlay, Census data
visualization and Territory Management to drive better sales, improve business processes and engage
right customers at the right time.

Maplytics is available for Microsoft Dynamics versions CRM 2013 and above and supports all deployment
models of CRM On-Premise (IFD as well), CRM Online and Partner-hosted. It uses the API services provided

by Bing maps. The following are the highlights of Maplytics:

AN N N N N N e N T N N N N N NN N U U N NN
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Ease of access

Multiple language support

Plot any entity record on the map

Area of Service

Proximity Search

Auto Scheduling

Territory Management

Check-In

Bring your own icons

Multiple category on plot card

Multiple territory for a record

Spider Cluster

Building Marketing list

Pie Charts and Column Charts in Heat Map
Overlay

Merged Plot and Route view

Maplytics Security Template

Point of Interest search

Layer Menu

Concentric Proximity search

Bulk geographies upload

Shape operations

CRM / Dynamics 365 Customer Engagement
View travel distance on proximity search

innovative logic
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PowerApps Component Framework
Census data visualization

Support for CDS

Data grid resizable

Plot Saved Templates on individual records
Color coding of pushpins based on
configurable categorizations

Routing with multiple waypoints

Along the Route search

Ability to Save & Share Driving directions
Sales analysis made easy with Opportunity
and Sales Heat Maps

Summary Card on Detail and Heat Map
Configurable color for Heat Map measure
Include Maplytics component on the
Dashboard through configurable queries
Geocoding Confidence Rating

Compatibility with Dynamics 365 App for
Phones and Tablets

Route Redirect for turn by turn navigation on
mobiles and tablets

Seamlessly integrated within Dynamics

Check-In

Page 6 of 161
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Language Support

Maplytics is a multi-language solution currently available in six different languages namely:

©

e English

e Spanish (Espafiol)

e German (Deutsche)

e French (Frangais)

e Portuguese (Portugués)
e Turkish (Tark)

Set Personal Options

Change the default display settings to personalize Microsoft Dynamics 365, and manage your email templates.

Genersl | Synchronizstion | Actividies | Formsts | Email Templates | Email Signatures | Email | Privacy | [anqusges
Select the language you prefer to see Microsoft Dynamics 365 displayed in

the displsy |s for items such as menus and dislog boxes.

h
=h M |

English

s 6} MAPLYTICS™

Maplytics auto-detects the user language
set in Dynamics CRM and sets its
language accordingly.

To check user language set in Dynamics
CRM, please go to Settings > Options >
Languages

Page 7 of 161
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Maplytics Configuration (Personalization)

Each user of Maplytics can customize Maplytics configuration according to their preference. The user can
configure Zoom level, Current Location, default origin and destination and a couple of other settings like
Map more, default summary grouping, etc. Please go to Settings > Maplytics Configuration Details >
Select Maplytics Configuration record for the required user (users added in Team Maplytics)> Set
according to the preference

Refer to ‘Maplytics Configuration Details (Personalization)’ section of Installation Manual for a detailed
description of personalization settings.

Maplytics Security Template

System admin and Maplytics admin can provide selective access of Maplytics actions to the Maplytics
users. They can select the relevant Mass actions & other actions and provide the access of the same to
the respective Maplytics users on the map.

Go to the Settings > Maplytics > Maplytics Security Templates > New

Dynamics 365 ~ | Maplytics | Settings > Maplytics Security Templates

= A Show Chart W Delete | v () Refresh [ Emailalink | ~ o Flow ~ [ RunReport “ B Excel Templates “ @ Export to Excel | v

@ Home

. . . o o
_—_ . B Active Maplytics Security Templates
# Pinned v
v | Name ) Add...TL Aut... T, Cha... T, Cre.. T Cre.. T Cre.. T} Cre.. T} Do.. T Exe... T
Maplytics
Field Sal N N: N N N | | = ) N:
B Maplytics Dashboard... i male ° ° ° ° ° e °
B entity Maps Marketing No No No No No ] No No
Bl Maplytics Templates
| Maplytics Configurat...
J B Mapiytics Security Te...
& License Registration
B Territories
g Teams
B routes
v
Al # A B C D E J M N O P Q s T U vV X Y oz
ords that start with this letter
1 -2 of 2 (0 selected)
B Settings o

Go to General and provide a name for the template. Under the section of Maplytics Configuration Details,
add the Maplytics Configuration Detail records of the Maplytics users whom the created template has to
be assigned.

(o) & maeLyTics: Page 8 of 161
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MAPLYTICS SECURITY TEMPLATES
Field Sales

General Action Configuration  Related

Name Field Sales Maplytics Configuration Details
v | User TL | Product Name T | Distan... Tl
Peter Asht. Maplytics Mile
John Parke Maplytics Mile

Go to Action Configuration > Select the required actions to be made available to the users selected

General  Action Configuration Related

s Actions

znag

Actiens

To remove the users from the list, Go to Settings > Maplytics Configuration Details > Select the record of
the required user> Remove the lookup value for the field of ‘Maplytics Security Templates’

(o) & maeLyTics: Page 9 of 161
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o Maplytics

General Auto Scheduling  Related

Distance Unit Mile Along The Route

Distance 00
Optimize Direction No Default Location -
Live Traffic No Records Per Page In
Grid 50
Route Opticn Shortest Time Zaom Level
& Map Center
B User @ £ Peter Ashton
Heat Map Type Boundary Maplytics Security A Feld sa
ield Sales
Template
Summary Grouping City
Set As Destination None
Default Template —
Set As Origin None
E3 Active Status:  Active Save
Note:

o All the actions will be visible to a user, if no template is assigned to the user
e Only System Admin and Maplytics Admin will be able to access the Maplytics Security Template Entity

@ncus.é QP MAPLYTICS" Page 10 of 161
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PowerApps Component Framework

User can add custom controls on fields or grids within Dynamics CRM. These custom controls will help the
user to view the respective records on the map on the record form or the entity grid without switching to
any other screen. This will enhance the user experience while working with views and individual records.
User can add the following custom controls:

Map View Control for Record

User can add this control on any of the field with the Data type ‘Single Line of Text’ of the record to view
the respective record plotted on the map. User can further view the Address and geo-coordinates on the
hover of the pushpin.

To add the control to a field within a record form, user can follow the steps mentioned below:

1. Go to Settings > Advanced Settings > Customizations > Customize the System > Components >
Entities > Required Entity
Here, we have taken the Lead entity for an instance. Within Leads, go to Forms > Main Form > Select
a field > Change Properties

Save Edit Select Form Upgrade

Solution: Default Solution Field Explorer >

Summary Form: Lead

F Map e L Filter Custem Fields M
Details . ¥ Only show unused fielcs

(5] GDPR Optout

4 Marketing

f&] Marketing Lists

4 Processes

L
{ il record on
& mae

e Uie 55

[ New Field

Note: The data type of the field on which user needs to add control should be ‘Single Line of Text’.

@ncs.é @ MAPLYTICS™ Page 11 of 161
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2. Go to Controls > Add Control > Select Map View Control for Record > Add

Field Properties 7 %

Medify this field's properties.

Display Formatting Details Events | Business Rules I Controls I

—Label
Spectty the label for this field In forms. Add Control
*
Label View record on Map Select a custom control from the field.

Pisplay label on the form

_‘

—Field Behavior MapViewCantrol

Specify field-level behavior Metadata Control

[Field is read-only PostLoad Picklist Cantrol

Maplytics — Map View Control for Record

—Locking
Specify whether to lock this field on the form. Modes:
[0 Lock the fiewd on the form Typest SingleLine.Text
&P MAPLYTICS™
Visualize address on the map. Hover over
7Visibi|i1y the pushpin to show the address details.
Specify the default visibility of this control.
Visible by default
—Availability

Specify the default availability of this field on phone.
Available on phone

Note: Please uncheck the option of ‘Display label’ within the field properties for better visualization.

@,
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3. User can choose to allow the control on Web, Phone or Tablet. Click on ‘OK’ > Save & Publish.

Field Properties 7 %

Modify this field's properties.

Display | Formatting = Details | Events | BusinessRules | Controls
Control Web Phone Tablet
Text Box (default)
IMap lytics — Map View Control for Record . O O X I
Add Control..
Maplytics — Map View Control for Record
Property Value
Field Property * A

Contro

4. User can open any record of the entity to view this control added on the field.

Dynamics 365 \» Maplytics Sales > Accounts > A Datum
= New & OpenOrgChart [ Deactivate 3 Connect ] Delete () Refresh
@ Home
o A. Datum Prashant Sonare -
(® Recent v Account Owner
% Pinned D4 Summary Map Project Price Lists  Details Field Service  Scheduling  Files  Related
ACCOUNT INFORMATION " . + Primary Contact
My Werk Timeline v
- Account Name [A] Vincent Lauriant
& Dashboards 0
. A. Datum '
Activities ail
(3] Chu;ung E @ Auto-post on wall A. Datum s12pm vincert@adatum.com
Customers Ss‘;-!;z A nt: Created By Prashant Sonare. .
Tajhu £ Business
A Ac i
I8 Accouns /) 012-156-8778
{3~ Tang-shih &
R Contacts & aroke;
Changhua.,_ — CONTACTS
Sales Nan:t'ou
Ta-ch'éng B
& Leads Lun‘peiy Chu=shan l%
Yuan-ch'ahg Kuang
[ Opportunities Chu-chii - No data available.
Tung:shih '“\j"‘j”
B Quotes . A 25 miles 504
A
n Sales < Active & Save

innovative logic
I

MOGIC

60 MAPLYTICS™
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Map Edit Control for Record

User can add this control on any of the field with the Data type ‘Single Line of Text’ of the record to view
the respective record plotted on the map. User can further drag the pushpin around and drop it on
location to update the new Address and the geo-coordinates for the record. User can also type in the
address in the space provided and click on the update button to update the Address and the geo-
coordinates for the record.

To add the control to a field within a record form, user can follow the steps mentioned above while
selecting ‘Map Edit Control for Record’ in the Step2. After adding the control user can open any record
of the entity to view this control added on the field.

Dynamics 365 Vv  Maplytics Sales > Contacts > Adrian Dumitrascu

= New [® Deactivate A& Connect T Add to Marketing List R, Assign Emailalink [0 Delete () Refresh @ Map B9 Process 9 Geo Code
@ Hom : .
o el Adrian Dumitrascu SYSTEM
® Recent Contact Owmer
5 Ppinned Summary Map Details Scheduling Files Related
CONTACT INFORMATION n— v - Company
el A Timeline b
% Dashboards First Name 8 Adventure Works
Adri
Bl Activities ran
Name Auto-post on wall Adrian Dumitrascu =

Customers D Contac By SYSTEM
8 Accounts -

&
I/\ Contacts >sllo M

er Clut
Sales
§ Leads
Randbur
0] Opportunities 9
B Qquotes
BBing. o M cec 0 2010beotln oo

H Sales Active =

() innovative logi
@ih::lt:‘fié

60 MAPLYTICS™
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Map View Control for Dataset

User can add this control to any entity to visualize all of the records of the view or sub-grid on a map. User
can further hover on the pushpins to view the information regarding the records. The information on the
hover of the records is customizable. To add more information on hover, please refer to the section of
Advanced Settings within the Entity maps in the Installation manual. User can also click on the pushpins
to highlight them. Highlighting multiple pushpins can help the users to perform various actions on all the
highlighted records at once. User can also right click on any pushpin to open the respective record.

To add this control on an entity grid, user can follow the steps mentioned below:

1. Go to Settings > Advanced Settings > Customizations > Customize the System > Components >
Entities > Required Entity
Here, we have taken the Contact entity for an instance. Within Contacts, go to Controls > Add Control
> Select Map View Control for Dataset > Add

Add Control

Select a custom control from the field.
Read Only Grid
Time Entry Grid

Timeline control =

Maplytics - Map View Control for Dataset

Modes: =

Types: Grid

rid viewon & I 6’ MAPLYTICS™

View the recorcs in
map. Hover on pusi
record details. Visui

@un‘%‘:&" K’MAP'—YT'CS" Page 15 of 161
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2. User can choose to allow the control on Web, Phone or Tablet. Click on Save > Publish.

» I | = show Dependencies
File

m Contact
2

“ &1 Information

Solution Default Solution

» [Connector Connector
> |34 Contact
b @ Contact Price List

» B Data Map
> [ Database Version
> [ Delegation

b &, Document Location
i [ 34 Duplicate Detection.

b % Ema

> By Email Server Profile
i [&] Emai Signature

> ] Email Tempiate

b [5) Entitlement

b &) Entitiement Tem

B Sselution Layers &y Publish @ Managed Properties @Help ~
General | Frimary Field | Controls
Control Web Phone Tablet
Read-only Grid (defaut
I Maplytics - Map View Control for Dataset O 0 x I
Add Control.,
Maplytics - Map View Control for Dataset

Property Value

Dataset Display_Key

3. User can open any view of the entity to view this control.

s 365 v

Y Home

® Recent %
52 Pinned v
My Work

Dashboards

Activities

Customers
I Accounts

R Contacts

Sales
&? Leads
EY Opportunities

B Quotes

E Sales G

innovative logic
I

mo

EiC

Maplytics  Sales Accounts
B Show Chart New [i] Delete (D Refresh &9 Detail Map & HeatMap %) Email a Link
Accounts: No Campaign Activities in Last 3 Months
@
¥
@)
v 4
3 \ .‘>
- Hudson Bay
Gulf of Y J
O o
A
G
Atlantic

Sargasso Sea Ocean.

> Bing

60 MAPLYTICS™

o Flow fi] Run Report

ICELAND Bcoisi 9
NORWAY | Q

] @

9
ALGERIA s cover

MAURITANIA | ' by ‘ T
~ | MAU | NiGer | suban
BURKINAFASL?(
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Detail Map Control for Dataset
User can add this control to any entity to visualize all of the records of the view or sub-grid on a map. User
can also perform some Maplytics functionalities. This will provide the user with the freedom of using
Maplytics abilities right from the grid page without switching to any other screens. This control will be
available in our upcoming release.

User can perform the following Maplytics features:

e Plot entity records

e Proximity search

e POl locations

e Route optimization

e Plot categorized data
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Individual Record Map

A tab to display an Individual Map section has been added by default on the Account, Contact and Lead
records as a part of the Maplytics solution.

ACCOUNT No. of Employees
A. HANSA PERSAUD & SONS
Summary Tab Map Project Price Lists Details Field Service Scheduling Related
No Auto Geocoding Yes ¢ 3 a I Richmond
Street 1 private bag 10306 2 8‘” 4  park Ocea o
< & GRECNAIDE View
sS4 % &5 ‘
et 2 E+
Sewaren Arthur Kill t
et 3 ¢
)"\ Great Kills Park
Boynton Beach Fod
Staten Island Great Kills
3pm: WOODROW Harbor
on1 | Greel
State/Province NY
Barber w “,fa"““”
Z >
z 10309 : o gl
USA ‘aa0 ) Outerbridge Crossing
Latitude
ati 4054336 -
56
ongitude -74.20697
Perth Amboy 2500 fest Sk
erritory (T New york post... pBing © 2015 HERE, ©.2015 Microeoft Corparation Terme

Here, two types of pushpins are plotted on the map:
e Orange color pushpin:

This always indicates the record location on the map. This pushpin is movable on the map. If the
user is not satisfied with the automatic geocoding information stored for the record, they can
manually move the pushpin to the exact location of their choice. As the user moves the pushpin,
the geocoding information (Latitude and Longitude) is updated in the bar at the top. Use the
Update button to save the updated geocoding information.

If the application is not able to geocode the address provided, the user can edit the address in the
Address text box and click on Search button. This will help the user to geocode the address.

Setthe ‘No Auto Geocoding’ option to ‘Yes’ available on the left-hand side, if the user has manually
set the geocoding information and do not want the automation to override the geocoding
information.

e Related Record Pushpin:
The related records are indicated by star pushpins. Related records correspond to all 1:N

relationship between the plotted Entity and the user can set a default relationship which should
always be plotted whenever this map is loaded. The user can further see related record
information by clicking on it. The user can plot maximum two relationships here. The user can use
‘Relations’ drop-down to select the available relationships for this Entity. Check the Entity Map
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Steps to add the Map to other entity

Maplytics™ — User Manual

settings (refer to Installation Manual) to set Default relationship and adding more relationships

to ‘Relations’ dropdown.

forms:

Open the Entity form and go to the ‘Insert’

tab.

Click on ‘Web Resource’ button, as shown

in the screenshot.

Mg Microsoht Dynamics CRM

HOME INSERT

B v v 3 3 ¥ 3 ¥ (&) Web Resource

S oD o0 O B = &S

Section Three Three Two T T One Sub-Grid Spacer Quick View Bing Navigation
- Columns Columns Columns Celumns Columns  Celumn Form Notes Maps Link

3 Tabs 2Tabs 1Tab Control

4 Opportunity Solution: Default Solution Web Resource
Summary form: Qpportunity Add an existing Web resource to this
Map form.

t Line Item: 4 -
=S ‘Summary You can also define how the Wen |
Quotes ;’ resource will be named and formatted
_______________________ on the form.

5

Add Web Resource -- Webpage Dialog

Add Web Resource

Add an existing web resource to the Form,

General Fermatting Dependencies

Web resource

‘Web resource * aﬁ ikd_fMaplytics/Maplytics.Individual Map.htm|

Q

Field Name and Properties

Name * WebResource_ |Map

Label * Wap

[]Display lzbel an the Form

Visibility

W visible by default

Web Resource Properties

Custom Parameter(data)

1 Restrict cross-frame scripting, where supported.

= Pass record object-type code and unique identifier as parameters.

In the Add Web Resource dialog, select
“ikl_/Maplytics/Maplytics.IndividualMap.html”
web resource and check the Pass record object-
type checkbox as shown in the screenshot.

Click OK, then Save and publish the form to see
the Map on the entity form.

©

innovative logic
I

imnoGIcC

60 MAPLYTICS™

Note: To plot a particular address on the Map, it should be geocoded and the Latitude & Longitude

should be set for that address. For geocoding you need to execute Maplytics Geocoding workflow for
the records.
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Area of Service

The user can view the data in a proximity or a region around an individual record as defined by the user

in the Area of service.

Summary Map Area of Service Accounting Details

Details

Versium Predict Insights ~ Project Price Lists  Linkedin Company Profile  General  Partner Program

Area of Service

Search Option
Proximity v
Proximity

@ Distance

12 Miles b4

Select Datasource

Account v Accounts - Staten isla ¥

teadin
< g

) Cluster map

Search Option

8y Location v NGy
B9  Current Location
4864 at ARTHUR KILL ROAD StatenIsianc| @
Proximity ! AMROALE
® Distance 2 Time
PN @ Show Travel Distance
1.2 Miles v

Select Datasource

Add Area of Service tab

To add Area of Service tab, Open the Entity form and go
to the ‘Insert’ tab. Click on Web Resource button, as

shown in the screenshot.

HOME I INSERT I

iyl Oowd@Es=s &

I @ web Resource

Add Web Resource

Add an existing web resource to the Form.

General | Formatting | Dependencies

’5':] 53] FrRAME
Section Three Three One  Sub-Grid Spacer Q.uck\uew
HON | ot Columes | Collensis:Colmes Couvr< Column Timeline
3 Tabs 2Tabs 1Tab
7 X A
In the Add Web Resource dialog, select

“ikl_/Maplytics/Maplytics.AutoSearchFilters.ht
- ml” web resource and check the ‘Pass record

—Web resource

Web rasource ®

® iki_maplyticsm. ap\‘,-tics.AulcSearchFﬂlers‘rﬁ

object-type’ checkbox.

— Field Name and Properties

The preferred number of rows in formatting is 15.

Name * WebResource. [res of senvics

Label * |Anea of service

‘ Click OK, then Save and publish the form to see

O pisplay label on the Form

the Map on the entity form.

— Visibility
& visible by default
) Enable for mobile

s

—Web Resource Properties g

Custom Parameter(dats)

Restrict cross-frame scripting, where supported.

=
FEZH Pass racord object-type code and unigue identifier 3 paramaters.

O
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Create an Area of Service field

To save the values entered in the Area of Service, the user needs to create a field for the Entity for which
Area of Service has been added. Go to Entity form > New field. Enter the following values:

Name - Area of Service

Data type — Multiple Line of Text

Maximum Length — 10000

Select the field in the respective Entity map for the Area of Service field.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Categeory Configuration  Configuration  Advance Settings  Related

Title * | Account Name | I Area of Service | Area of Service | I

Template | | I}

The values when entered and saved into the Area of Service, the corresponding data will be plotted on
the map.

View Area of Service data on a map
To view the Area of Service data on the map, there are two ways:

e Using Map button —the results are shown in a map opened in a different tab
e Adding Detail map on form —the results are shown in a map added on the same record

Using Map button

The user can open the Detail map to view the corresponding Area of Service data plotted on the map.

[©] New && Open Org Chart I:g Deactivate B Connect N T Add to Marketing List A, Assign [Z] Email a Link ]ﬁ[ Delete O Refresh

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS 366,466.00
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Adding Detail map on form

To add a Detail map to show the data of Area of
Service, follow the steps mentioned below:

Open the Entity form and go to the ‘Insert’ tab.
Add two columns.

After adding Area of Service tab in the entity form
as mentioned above, follow the steps mentioned
below to add the Detail map on the entity form.

To add a detail map, Click on ‘Web Resource’
button. In the Add Web Resource dialog, select
“ikl_/Maplytics/Maplytics.DetailMap.html”

web resource, add “form” as custom parameter
(data) and check the ‘Pass record object-type’
checkbox as shown in the screenshot. The
preferred number of rows in formatting is 15.

Click OK, then Save and publish the form to see
the Map on the Entity form.

—

=omEeE || INSERT ||

= IS S > > 5

\=5| |oool [ooo |local)(Cool (OO

Section Three Three Two Two Two
- Coiumns Cclumns JColumns jColumns Columns

3 Tabs 2 Tabs

Web Resource Properties 7 x

Modify this Web resource’s properties,

Gensral | Formatiing  Oependencies

~Web resource

]

Web resouree® @ ii_/Maplytics/Maplytics.DetailMap htmi

—Field Name and Properties

Name * Wsolesource_DetaliMap

s * Detal Msp

5 Display labet on the Form

— Visibility
¥ visiie by Gefsul

@ Erapie tor mobie

—Web Resource Properties
form

Custom Parameter{data

Res

21.frame scrpting where suppored

Pazz record object-type code and unigue identifier 3 parameters.

o e

Enter the required values into Area of Service, save it and click on the refresh button on the Detail map to

view the data plotted.

Summary Map Area of Service Accounting Details  Details

Versium Predict Insights

Project Price Lists

Linkedin Company Profile  General ~ Partner Program

Area of Service
@ pLOT

Search Option

N Layer Menu

) < teading

Proximity v
Proximity
@ Distance Time Vi)
12 Miles s Q = Cluster map 4
Search Option
Select Datasource 8y Location v ELTINGY)
Account v Accounts - Staten isla ¥ B9  Current Location
4864 3t ARTHUR KILL ROAD Staten Isianc| @
=] Proximity ' Awikons
® Distance D Time
\‘ Show Travel Distance
12 Miles v
Select Datasource
innovative logic @ ™
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Detail Map

Maplytics buttons are added to the Entity forms as well as the Entity Homepages so that it can be easily

accessed from anywhere.

@ & Open Org Chart

Summary Tab Map

T New

ACCOUNT
A. HANSA PERSAUD & SONS

Project Price Lists

ACCOUNT INFORMATION
Account Name

A. HANSA PERSAUD & SONS

[‘3 Deactivate

A Connect | v

Annual Revenue

366.466.00

Details  Field Service  Scheduling  Related

Timeline

= Addto Marketing List .QL; Assign [Z] Email 2 Link ﬁil Delete O Refresh

No. of Employees

-+ Primary Contact

CONTACTS

Using this button, the user can invoke the Maplytics application for detailed geographical analysis.
Maplytics provides both ‘Heat Maps’ view as well as ‘Detail Map’ view of the Dynamics CRM data. These
views can be easily accessed from the buttons added to the command bar in entity home pages and

other views.

L’;’_J Show Chart = New IE[ Delete N

=) My Active Accounts

O Refrash I &9 Detail Map ﬁ*’ Heat Map I &) Email a Link ~

o Flow ~ [l RunReport ~

0

Search for records

v | Account Name
0969 Ocean View Road
10003 Account
A Damc

A. Datum

W innovative logic
@il‘IDEiC

T Main Phone Tl Address 1: City Tl
(415) 555-9933 Jersey
4578755
= Alberta

6@ MAPLYTICS™

Tl Email (Primary Contact) T,

Primary Contact

Adrian Dumitrascu Adrian@adventure-works.com

Page 23 of 161




Maplytics™ — User Manual

Selecting a few records and clicking on the ‘Detail Map’ button on a particular Entity Grid view will open
the following window;

iESS | i

@ PLOT & POl ¢? DIRECTION
AN

/ N\

ROSEBANK
7 2

SHORE ACRES:
oY

Henry Kaufmann
Campgrounds

It will automatically plot the selected records from the view on the map. Records that do not have their
latitude/ longitude will be ignored and will not be plotted on the Map.

@Inagv&mlak @MAPLYTICS" Page 24 of 161




Maplytics™ — User Manual

Plot

There are five different search options to plot the data on Map:
e By Location
e By Region
e By Drawing
e By Territory
e By Template

Note: The user can also configure the ‘Search Options’ to be visible on the map. Refer ‘Setup
Entity Map’ section of Installation Manual for further instruction.

By Location
@  Plot Records
Cluster map
This helps the user to plot the data using the geocoding of each record. Search Option
By Location T

By Location search option also allows the user to perform
Proximity/Radius Search based on Distance or Time.

Current Location

75 at RADFORD STREET Staten Island NY

Proximity

The Current Location is fetched from the user’s personalization record. © Distance Time
The user can also set a new current location using the contextual menu. shew Travel Distance

. Mil T
Refer to the section of the Contextual menu. -

Select Datasource
Account ¥ || Select View v
+

Select Category
@  Plot Records

Account Select Categc ¥

Cluster map Select Overlay
Search Option Select Overlay v
+
By Location A =] »
Current Location
1073 Richmond Hill Rd, New York, NY 103
Proximity
® Distance Time Select Datasource dropdown will list out all the Entities (OOB and
Show Travel Distance Custom) configured for Maplytics and the active views (System views,
Miles v Personal views, Maplytics Dashboards and Marketing Lists) that are
SR available for the selected Entity type. The user can choose one of the
Account ¥ || Select View ¥ . . . .
e views to plot all the records available in that view.
+ System Views
Select Category Active Accounts
All Accounts
Account Sele My Active Accounts
Select Overlay Vendors i
Personal Views
Select Overlay Accounts - Staten Island . TO/T o 7
N Service providers - France Note: The user can also configure the ‘Views List’. Refer ‘Setup
Dashboards . . . . .
= My New Accounts This Month Entity Map’ section of Installation Manual for further instruction.
Sales By Postal Code
Marketing Lists &

Campaign - Customer's list
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The user can select additional entities using the ‘+’ button. The user is
allowed to specify a maximum of 3 Datasources for plotting the data
at a time. This allows for viewing Dynamics CRM data across Entities
in a single view on the map.

After selecting multiple entities, the user can click on the ‘Search’
button to plot the records for the selected entities. This helps the user
to visualize three entities on a single map.

Note: User can define the colors as well as pushpin shapes of
the Entity — view combination. Refer to ‘Setup Entity Map’
section of Installation Manual for further instructions.

@  Plot Records

Cluster map

Search Option
By Location

Curmrent Location

Proximity
® Distance
Show Travel Distance
Miles
Select Datasource
Account ¥ || Active Accounts

Lead ¥ || Leads - NY

Opportun ¥ || All Opportunities
Select Category
ccount Select Categor ¥

Cpportunity | | Select Categor ¥
Lead Select Categor ¥
Select Overlay
Select Overlay

+

75 at RADFORD STREET Staten Island MY 103 \.,

© Time

v

v
X @
x @
X @

. Q 8 sliemiey, POt ﬁﬁ S o
]l QPLOT = QPO of DIRECTION e A5 4 \ LA § colegeof
- W& Sors 1 3 Staten
d S (e ! § S o
Darth Amhau lincting bt 4 ;7 Y i f 2, (=] 5
~ & ¢ S .
R4 Layer Menu Artaret: 8’\ b ) Ry,
RE § [ n ; RA %,,&@
| @ PlotRecords & B RS 4
[ Cluster map H =
| Search Option j
Carteret i Q
‘.'ISVG(')d of'
By Location ¥ #Meadows

LA TOURETTE PARK:

8 Grear E

Current Location
" Reading

) Show Travel Distance
Miles b

Select Datasource
Account ¥ || Accounts - State1 ¥ | X )
X

Lead ¥ ||Leads- NY v

‘ = 3
\ Opportu ¥ | | Open Opportuni ¥| X @ B
! g
Select Category 2|
Account Select Categ ¥ E ﬂ
Y= =
< Lead Select Categ ¥ a A il a
Iy Opportuni | | Select Categ ¥ Q M;n;/;f“ex
e — i =3 =\ Park
S e pmsmny
| PEEE . .
& i il & = Z [ View Data

ey,

gichmond Rd

75 at RADFORD STREET Staten Island N 9’ 3 United
Proximi Ziddlege, Hebrew
oximity Cemetery

® Distance J Time

s ®
=
@ OAKWOOD

OAKWOOD BEACH!

- 68 Greor Kils Park

Great Kills
Harbor

2500 et Ahm; <

€2010 HERE  © 2010 Wicrosoft Corporation Jerms.

(o) GomapLymics-
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By Region
This helps the user to plot the data by the region of records, i.e., City,
State, County, Country, PostalCode, PostalCode Sector, Postal
Code(Outward Code), Postal Code Areas. The user can plot multiple
regions under a particular region type.
e Postal Code: The smallest postcode category, such as a zip
code.
e Postal Code Sector: The second ‘1’ is called “Postcode Sector”.
Example: CA11
e Postal Code(Outward Code): This is called Outward Code, the
part of the postcode before the single space in the middle.
Example: CAl
e Postal Code Areas: The next largest postcode category after
Postcodel that is created by aggregating Postcodel areas.

Note:

@  Plot Records

Cluster map

Search Option
By Region

Select Region Type

Select Region

Select Region

City

State

County

Country

Postal Code

e Sector

al Code Are

utward Code)

27

SEECTUVETTS
Select Overlay

o The regions that were plotted using the option of Post code Areas before will now be plotted

by using the option of Post code sector.
o The regions will be plotted as per the Bing maps.

m oselle
(<

£ Layer Menu

|
=

@  Plot Records |

Cluster map

Linden ¢

Search Option

L By Region ;
E y Reg

Select Region Type

County

Select Datasource

\ Account ¥
+

Select Category

Accounts - Statel ¥ | fam

Account Select Categ ¥
ect Overlay

Select Overlay Raritan Bay

Select Overlay g

View Data

innovative logic

moGic 6@ MAPLYTICS™

Breezy
Point

int
Park
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By Drawing

This helps the user to plot data by defining their own shapes. The user can use the ‘Drawing tool bar’ to
draw the following shapes:
e Freehand drawing
e n-sided polygon
e (Circle
e Rectangle

The user can further edit the drawn shapes by using the following options in the Drawing tool bar:

Edit

Erase

Fill color
Stroke color

E_'] Road §

[ clustermap
Search Option

[ By Drawing

Define shapes

ACAEICNEN O IEAN

Select Datasource N

Account ¥ ‘ Accounts - Staten ¥ | Gy
+

Select Category

Account ‘ Select Categc ¥

. Select Overlay

Select Overlay v
+
o

TODT HiLL

’ Note: While creating an n-sided polygon, use the ‘Esc’ key from keyboard to close the shape. |
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By Territory

This helps the user to plot the data defined in a particular sales @ Plot Records
territory. The user can select multiple territories to plot on the
map in ‘Select Territory’ option.

[ Cluster map

Search Option

By Territory
Select Territory

10301 - Staten Island

10302 - Staten Island

Select Datasource

|Accauni v ||A.cmun15 - Staten sl ¥ @

+
Select Category

|Account ||Seled Category ¥ |

Select Overlay

Select Overlsy

Y&

,\4 Road PN

@  Plot Records

() Cluster map
Search Option

By Territory

Select Territory

110309 - Staten Island

10310 - Staten Island

Select Datasource

7 ‘Account ¥ ‘ Accounts - Staten ¥ ‘
+

Select Category

[ | Account ‘ Select Categc ¥

Select Overlay

i Select Overlay v
+
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By Template

This helps the user to plot the predefined search criteria in Detail Map. The user can save the search
criteria as a template and use the ‘By Template’ search option to quickly plot the data with that search
criteria. This helps the user to save a considerable amount of time.

@  Plot Records

! Cluster map

Search Option
By Template ¥
Select Maplytics Template

Concentric Proximity Search by Industry r

The User can also define the access level of the
Template as described below:

e Personal — The users can limit the usage of
this template to themselves

e Public — Anyone in the organization can
use this template

Apart from saving information of Plot Records,
Category card, and filters from Grid, it also saves
the Zoom level & Center of the map.

For example, if any user is assigned with a task
where the requirement is to regularly plot ‘My
Active Accounts’ records in 2 miles of a
particular location and filter a particular
Industry, then the By Template option can be
beneficial.

Select Owverlay

select Overlay ¥

+

e e
Save The Template B8

Add to existing template
* Create new template

Golf Course - 2 Miles|

Access Level ;

Personal ¥

Note: Please assign ‘Maplytics User’ security role to Team Maplytics before exploring this

functionality.
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Cluster map

The user can select this option to group the closely positioned pushpins into a cluster. A cluster shows the
number of pushpins in the cluster. The user can zoom in further to break down the cluster into smaller
clusters or zoom out to group closely positioned clusters into one.

Cluster Area

The user can hover on any cluster to see the ‘Cluster area’ which shows the data spread. The data spread
is based on the area covered by the pushpins existing in the cluster.

Contacts - Staten island leads (99) OReset | = Related Reco... | ~ Mass Actions

‘E ‘Fu!l Name Company Name Y | Business Phone v ‘

Jack ledwith some_26925@inogic.com A Datum Integration 6462879571
Rob MEDINA some_26925@inogic.com A Datum Corporation 6462879571
FRANK VACCARO some_26400@inogic.com Organo 6467021843

Edward Watson some_26400@inogic.com Motor corporation 6467021843
Jessica Anderson some inoqic James wood 6467021843 hY

= e @

2 (»)(m) |50 v/ itemsperpage 1- 50 of 99 items

) o mapLyTics Page 31 of 161




Maplytics™ — User Manual

Spider cluster

The user can click on any cluster to view the pushpins existing in the same in the form of a ‘Spider cluster’.

@ PLOT & POl

Contacts - Staten island leads (24) ZReset | & Related Reco... | ~ Mass Actions
‘ @ ‘ Full Name Y | Email Y | Company Name Y | Business Phone ) ‘
@ | [77] | K. ERIK BJORNEBY | some_25322@inogic.com | James wood | 9172957146 -
B Nick Rogers some_25322@inogic.com Motor corporation 9172957146 n
B 7] Bobby Cook some_26223@inogic.com Berry sweet industries 3475895721
@ S. CHARLES MAGRINO some_26223@inogic.com Organo 3475895721
B @ Wilson Coleman some inogic.com Avid 3475895721 S
ol o > 50 v | items per page 1-24of 24 items

Note: Spider clusters can be visualized only for records less than or equal to 50.

@HE”&"‘E 6’ MAPLYTICS™
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Proximity Search

There are two different options to perform a Proximity Search.
Distance-based Proximity

This option will calculate the straight line distance between the current location and all the points which
fall in the proximity parameter as shown below:

=
BRIGHTON. <
s

E‘] Road

«\" £

x, =2 ” BRIGHTON.
i\ ‘ A #
Hession & Sons s
G — e Line-of-Sight Distance: 1 24 Mies
Plot Records = f V< | _Shortest Travel Distance: 1.43 Miles
s ; 5 ] " Address 1: 381 at BUCFANAN AVENUE Statensla
[ Cluster map % \ K./ 4 ~'nd, NY 10314 )
4 s \ 4 3 == Revenue: $939,576.00

. *

S

PLETON

il

|
oo

] Search Option SHOURE ACRES.

| ‘ By Location

:“ Current Location

't ‘ 700 Rockland Ave, New York, NY 10314 ‘ @

Proximity
® Distance © Time

Show Travel Distance

|3 Miles

| Select Datasource

!Account Y ‘ | Accounts - Statel ¥ |

. Select Category
= | Account ‘ | Select categ ¥ |
"4 Select Overlay

| setect Overlay v

Enter the radius for the Proximity search. The user can also add decimal values with a scale of 2 for the
radii. The Proximity can be provided either in Miles or Kilometers. The User can also hover over a pushpin
and see the distance from current location.
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Concentric Proximity Search

This new addition to Proximity based on Distance allows users to perform up to 3 proximity search
simultaneously. The user needs to enter the distance values separated by a comma (,) and all the points
that fall in the defined proximity parameter will be plotted.

Layer Menu

Ol Plot Records

N *  Sherigar & Sons
4

|| PDIRECTION - SETASCU.. - SETASP..

. | 435at STEWART AVENUE Staten Island NY
910314

Line-of-Sight Distance: 1.13 Miles
Shortest Travel Distance: 1.39 Miles

# Account Name: Sherigar & Sons

000006

—

ETNGVILLE

The Concentric proximity zones are represented by different colors for easy visual analysis. The user can
also click on individual proximity zones to highlight the circle and open the Summary Cards for that
proximity parameter.

The user can also filter the data points based on the proximity zone and their proximity distance from the
current location in the ‘View Data’ grid.

Accounts - Staten Island {130) ZReset |  Related Records | - Mass Actions
‘ ‘ Account Name T ‘ Primary Contact T ‘ Main Phone Y | Shortest Travel Distance T | Line-of-sight Distance Y | Proximity Zone T
=] @ | Abbas & Sons 7188520069
B @  Abdelmessih & Sons Abraham McCormick 2122501122
= Adamita & sons Adrienne McMillan 2124180645
B @ | Adams & Sons Benno Kurmann 2122068501
B Aguayza 8. Sons 2123082665
=] @ | Alello & Sons 2128165282

Note: User can enter integer value from 0.1 to 2000 for distance proximity search.
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Time-based Proximity

This option will calculate how many points fall in ‘x” minutes or hours of driving distance from current
location. The Proximity can be provided either in Minutes or Hours. The User can also hover over a
pushpin and see the distance from current location.

b 4
e b g *
y Weisberg & Sons
[s Cluster map ; 55 < Travel Time: 6 Minutes g
Search Option B . ‘ Shortest Travel Distance: 1.45 Miles
s emley. Pcmt‘ * \,}‘7 Zes 3 Address 1: 75 at RADFORD STREET Staten Island
8y Location v 4 55‘ 2 NY 10314 :
CinghELocaton j %, b 4 Territory: New york postaicode o :
> : ] Foe Annual Revenue: $344,430.00 2 2
700 Rockland Ave, New York, NY 10314 Y reavis %75 . 4
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Current Location

This is used in combination with Proximity to specify the center point for the Proximity search. By default,
this field displays the address stored in the Maplytics personalized record of the logged in user. This is
always represented by a green color pushpin on the map and also indicated right next to the current
location message box.

Show Travel Distance

While performing Proximity Search by Distance or Time, if the user wants to see the actual travelling
distance from the current location till each of the individual pushpins, they can select the checkbox of
‘Show Travel Distance’ to view the Shortest Travel Distance on the hover and view data grid.

Accounts - Staten Island (103) & Related Records

# | Account Nam: Y | Primary Contact Y | Main Phone Y [ Shortest Travel Distance v | Line-of-Sight Distance Y | Proximity Zone A
B @  Ab 184 3
B @  Abdelmessih & Sons 2.04 32 3
% @  Adamita & Sons Adrienne McMillan 043 0. 3
B ¥  Adams & Sons Benno Kurmann 3
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Category

This lists out all attributes of the selected entities. Users can choose the attributes by which they would
like to color-code the pushpins plotted on the map. The screenshot below shows the categorization of all

the records of Account, Lead and Opportunity on the basis of the attributes Annual revenue, Rating and
Est. Revenue respectively.

Note:
e User can choose respective categories for at a maximum of three different entities. Only one
category can be chosen for an entity selected twice or thrice.
o The user can define the color as well as shape of pushpins for each parameters of category. Refer
to Pre-Define Colors for Category section for further details.
e User can also choose the field attributes to be visible in Category list. Refer to ‘Setup Entity Map’
section of Installation Manual for further instruction.
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Data Grid

All plotted pushpins represent a unique record in Dynamics CRM and data grid helps the users to access
these records from the map screen, filter the data further and perform some mass actions.
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Filter Data:

The user can use the filter present on the top of every column to filter the data further. Order of columns
in the grid depends upon the Dynamics CRM View selected to plot the data and in the case of Marketing
Lists & Maplytics Dashboard records, it is same as that of the Entity-View selected in Entity Map. The users
can also customize the data columns to be visible in the grid by adding/removing columns from the Entity
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Reset:
This will reset the grid to the initial search.

Parent Record / Related Record:
This is useful when the user is dealing with plot related records functionality. The user can switch between
child data and parent data using this button.

Resizable Data grid:

Double click on Expand button to view the data grid in full screen. Double click on Collapse
button to view the default size of the data grid. Use can also click once and drag to resize the data grid to
the desired size.

Linden ;
Layer Menu Rahwa. @
infield = tong
| ¥ SelectAll @
7
@ Blank * @
@ Banking = U ;
Raritah 2
Accounts - New York (350) Reset | & Related Records
@ | Account Name Y | MainPhone Yy | Address 1:..y | Email Y | Expected.. Yy | Industry Y |Owner Yy | Sales Y | Teritory 'y | Website Y
] R.PETER KANAKOS & SONS 8464352048 10306 pamela10616@inogic.com 14976089 | Engineering Joe Smith 400000 10306 www.inogic14148.com -
7] | L PAUL CASTRUCCI & SONS 36577023498 10310 beth10516@inogic.com 14843411 | Transportation sams 800000 10310 http://www.inogic14040.com
] R.WERNER MORATH & SONS 5208663787 10308 robert10942@inogic.com 14779901 | Engineering Joe Smith 700000 | 10308 www.inogic14488.com
7 | Y. ANTHONY TAKOS & SONS 33982746370 10306 john11009@inogic.com 14719345 | Social Service William Smith 400000 10306 Www.inogic14558.com
] K. FRANK CAMINITI & SONS 41133044516 10314 james10792@inogic.com 14698054 | Transportation sams 290000 10314 www.inogic14333.com
7] | Z DARIUSZ MAKARA & SONS 14959555031 10314 judith10814@inogic.com 14685001 | Transportation sams 290000 10314 www.inogic14355.com
] | J.NJKATZ & ASSOC. INC. & SO... | 14141242839 10314 silkaly10483@inogic.com 14496539 | Engineering sams 290000 10314 Www.inogic14007.com
] | S.JAMES FEUERBORN, JR. & SO... = 7124852777 10307 lawris10932@inogic.com 14418039 | Social Service William Smith 1000000 | 10307 www.inogic14478.com
] | S.STILES SHAWN & SONS 39591012928 10314 mark10408@inogic.com 14304467 | Engineering sams 290000 10314 www.inogic13931.com
g US COOMBS & SONS 33719694353 10306 larry1033; 14372710 | Engineering Joe Smith 400000 10306 www.inogic13855.com
@ H.ELIZABETH DI SALVO & SONS | 391928040928 10304 chris10629@inogic.com 14337160 | Banking sams 200000 | 10304 www.inogic14161.com
7] | R.OMAR ELSHERIF & SONS 18792802791 10306 melanie1972@inogic.com 14332454 | Engineering Joe Smith 400000 ' 10306 www.inogic5217.com
] R.NASIR KHANZADA & SONS 2422958921 10309 stanley10653@inogic.com 14173892 | Engineering sams 200000 | 10309 www.inogic14186.com
] | S.JANIS VACCA 8 SONS 23584616947 10306 christopher10957@inogic.c... 14111729 | Transportation Joe Smith 400000 ' 10306 Www.inogic14503.com
o e —— s ey s - ; T T— | —— — .
" v | items per page 1- 200 of 350 items
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Highlight pushpins:
User can click on any record within the Data Grid to highlight the respective pushpin on the map. User can
also click on any pushpin on the map to highlight the respective record in the Data grid.
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Mass Action Buttons

The user has the option to take actions on the plotted records like adding to route or executing the
workflow on selected records in the grid. Defined mass actions are as follows:

e Add To Route: This option will add selected data points to the route. The user can add at max 25
data points to the route

e Save Data: The selected records can be saved as static Marketing List or Personal View in
Dynamics CRM

e Change Owner: The user can assign the owner of the plotted records by selecting a user ora Team

e Manage Territory: The User can assign or change the territory of selected records

e Send Email: The user can send a mass email to the selected records. This will open the list of
available email templates or new blank email

o Execute Workflow: The user can execute any on-demand workflow with this functionality

e Export To Excel: The user can use this feature to export data from the map to excel. This
functionality adhere to CRM security roles, if the user does not have the permission to ‘Export
Data to Excel’ in CRM then that user will not be able to export data from Maplytics

e Create Activities: User can create activities for non-activity Entity records currently selected in
“View Data grid.” The user can define the Activity, Subject, Duration, Owner(User/Team) and
Priority. The user can also select the number of activities they want to create from Mass actions.
The activity selected in respective Entity maps can be seen in the Mass actions list under the label
of “Create activities”, by clicking this label below window will open which will list the activity
selected in respective entity map.

e Auto Scheduling: User can use this option to schedule a plan for the plotted records. Refer to the
section of Auto scheduling.
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Tooltip Card

User can click on any pushpin to open a tooltip card. This o

card will display the data like Address, Account name etc. % R WALTER PRATHER

which is defined in the Tooltip Mapping section of the = DIRECTION =+ SETASCU.. =» SETASP..
Entity Map.

280 MEREDITH AVENUE STATEN ISLAND NY
USA

Full Name: R. WALTER PRATHER
Email: some_26443@inogic.com

Business Phone: 5183734439

Take An Action

CO0HOOE®

¥ R WALTER PRATHER

= DIRECTION =p SETASCU.. =p SETASP..

280N * SelAs Origin IN ISLAND NY User can also set a particular record as ‘Origin’,
USA| - SetAsDestination ‘Destination’, ‘Add to Route’ under Direction, ‘Set as

 fadTo Route | Current Location’ and ‘POl location’ from the Tooltip
Full Name: R WALTER PRATHER d
card.

Email: some_26443@inogic.com

Business Phone: 5183734439

Take An Action

COOROOE
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Hover:
User can hover on Dynamics CRM Records plotted on the map to have a quick glance at its details.
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The user can have a maximum 6 different attributes here apart from the title attribute. Refer to the ‘Setup
Entity Map’ section of Installation Manual for further instruction.

Quick Call to Action Buttons:

User can associate quick action buttons. This helps in saving time while switching between screens to take
actions. First four actions are the default actions and cannot be changed by the user, but they can modify
the rest of the actions. The default records are as follows:

e Change Owner £2}: Assign an owner to the respective record by selecting a user or a team
e Open Record & : Open record directly from this screen to edit any field
e Plot Related Record 2 : Plot One-to-Many Relationships/Related records of a particular record

) innovative logic
@il‘IDEiC

as shown below:
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Plot Related Records

Select the relationship to plot related record

[ account - customeraddress
(Account_CustomerAddress)
& account - contact
(contact_customer_accounts)

Select the required relationships from the list and click on ‘Plot Records’ button. Related records will be
plotted as shown below. Use ‘Parent Records’ button to switch between Parent and Related records data
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e Run workflow @ . The user can execute on-demand

workflows on an individual record. When clicked on Execute Workflow %

this button, it will open a window which will list down
all the on-demand workflows available for respective Select Workflow

Entity as shown below : | Inogic. Maplytics AssignTerritory Workfioy
Inogic.Maplytics.AssignTerritoryWoerkflow
Inogic.Maplytics.GeoCoding

The user can customize the rest of the actions according to their requirement. In this example, we have
added the following three actions:

e Email ©: Send email to this record

e Add Task ) : Add task to this particular record

e Appointment () : Schedule appointment with this record

The user can define these actions under ‘Advance Settings’ in Entity Maps. Go to Setting > Entity Map >
Select Required Record > Advance Settings > Tooltip Card Actions or refer to ‘Setup Entity Map’ section
of Installation Manual for further instructions.

Reset Map

User can use the button of ‘Reset Map’ to reload the map with the initial Detail map

settings.

Note:
e This action will clear all the data plotted on map
e The refresh map button will show the same data on the map in the following conditions:
o Expanding the map or plotting a route from a dashboard
Using the map button from an individual Entity record page
Plotting a route or a template
Plotting records by selecting the records from the Entity records page
User had set a default template for the Detail map

© © © e
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Overlay

This helps user to view the Dynamics CRM records along with shapes files
and existing territories plotted on the map. User can also view the ‘layer -

menu’ to select or deselect the layers so as to show or hide the same Cluster map

. . . . Search Option
respectively. Using Overlay user will easily be able to understand and

analyze the data spread in required shape file regions and territories.

By Location v

Current Location

User can select the following two options:
e Territory — This option helps the user to select among the list of
existing territories
e Shape file — This option helps the user to select among the list of
shape files Select Datasource
Account ¥ || Accounts - Statel ¥ a

+

Select Category

Proximity
® Distance Time
Show Travel Distance

Miles v

Account Select Categ ¥
Select Overlay

Select Overlay v

Select Overlay
Territary *

Shape file 2

Shape file in territory

A shape file should be saved in a territory in order to be visible in the list of the shape files. Follow the
steps mentioned below:

e Go to Settings > Business Management > Sales Territories > Create a sales territory > Save
e Go to Territory Map Preview > Select By Shape File > Choose a shape file > Save

TERRITORY
New York

General Define Geography ~ Configuration  Territory Map Preview Related
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MASSACHUSETTS {
T Ann Krbor| Worcesteh

Boston

Springfiels / XY TauntcliCoe

/ Protidence
O —1oto J

_~ RHODE
ISLAND.
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Convert overlay to territory

. [©] | New [I] Delete ) Refresh IJ- Convert To Territory I [ Email alink  o®
User can use this button to convert an overlay record
to a territory. After the overlay record is converted, it TERRITORY
. . . USA Census by State
becomes a territory which can be searched in the

option of ‘Territory’ in Overlay.

General Define Geography  Configurations  Territory Map Preview  Related

Territory Name " USA Census by State

Note:

e Supported file types for shape files are .shp, .kml and .geojson

e In a territory, either a shape file can be saved or geographies can be created
e Only one shape file can be saved in one Territory

Summary Card

The user can click on any enclosed area to get the summarized information of the plotted records in that
area in a summary card. The area clicked will get highlighted and the respective data will be visible in the
data grid. The user can customize the settings for this under the Summary card section in the respective
‘Entity Maps’. Refer to ‘Setup Entity Map’ section of Installation Manual for further details.
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With territories plotted on the map, Summary card also shows the link to open the respective territory

from the card itself.
3 10314 - Staten Island
Territory §10314 - Staten Island

Total Records: 26

Account - (All Accounts): 26
Annual Revenue (Average) $38,711 538 46
MNo. of Employees (Sum): 161, 300.00

Layer Menu

This helps the user to select the required data among the multiple data plotted on the map. The user can

use the toggle buttons on the Layer menu card to show or hide the required layers of the data to be shown
on the map without removing the same from map.
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Note: Layer menu card is collapsible but a user can not close this card exclusively.
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The layer menu card will show the following icons for the respective layers mentioned:

Layer type Icon Layer type
Data source k'.J Territory
Route POI
Proximity Cluster Pushpin
Drawing Shape Shape Operation

Region Shape
Plot-child

Overlay- Shape file

Territory Management —
Shape file

Note:
e Layer icon for Data source layer, POI layer and Plot-child layer will change depending upon
pushpins visible on map
o [f category is selected in the plot card, the layer menu card will show only the default pushpin for
the Data source layer

Show/Hide Labels

User can click on the ‘Show label’ @ button to view the labels for the pushpins, regions as well as
territories plotted on the map. User can again click on ‘Hide Label’ @ to hide the labels showing on the
map. The option for showing/hiding labels is available for every individual layer of data plotted on the
map.
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Note: Show Labels is available for less than 5k records.
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Show/Hide Territory List
With territories plotted on the map, layer menu will & lLayer Menu
also show an option of Show/Hide List for the layer

of territories. User can click on the show/hide list o :
= . . o B @ Teritory Layer = L@

button *= option to open the list of territories

plotted on the map. User can further select or -

deselect the territories which are required to be P @ AlAccounts )

plotted on map. v

W Territory List

[ Select Al

[+ 10304 - Staten Island
] 10305 - Staten Island
] 10306 - Staten Island
l# 10307 - Staten Island
[« 10308 - Staten Island
[« 10309 - Staten Island
l# 10310 - Staten Island

[« 10312 - Staten lsland
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Contextual Menu

User can right click on the map to open Contextual menu. It provides commonly
used features in Dynamics CRM like creating a new record, set
origin/destination or selecting map zoom level on the map. The contextual Directions >
menu provides the following options: Add To Route

Create New Record

Set As Current
Location

Set As POI Location

Save Settings »

Create New Record:

User can right-click anywhere on the map or POI result

icons and create a record for that particular location. This
will save the record with the details of the address and
the geo-coordinates (Latitude & Longitude).

What would you like to create?

v

I
Note: Create new record option will not available ECCCL“
ontact
for existing record pushpin | Lead
Directions:
e Set As Origin: This option will set the address of the pushpin/map location as the start location of the
route.

e Set As Destination: This option will set the address of the pushpin/map location as the end location
of the route.

Add to Route: This option will set the address of the pushpin/map location as a middle waypoint(s) of the
selected route. For example, the user has selected Point A & B as orgin & destination respectively for a
route and now clicks on the ‘Add To Route’ option, the Point B will remain as the destination and will
become the Point C. The address of the selected pushpin will become the Point B of the route.

Set as Current location: User can click on any pushpin or anywhere on the map to set the address of the
pushpin or the location as the current location respectively, which can be used for Proximity search.

Set As POI Location:

This option helps the user to set the location for the Point of Interest (POI) searches like ATMs, restaurants,
Airports, etc. Setting the POI location, user can search for various Geo-tagged & Bing mapped locations
around it.

Save Settings:
User can save the default settings for the following options. These settings will be saved in the

Configuration details record of the user:
e Current location: This will save the location as the default current location.
e Map zoom level: This sets the zoom level and map center for the Map. After this setting is done,
whenever the user will open the Detail Map, it will be zoomed down to the location set here.
e Origin: This sets the location as the default origin.
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Destination: This sets the location as the default destination

User can also click on any pushpin to get a contextual menu. Along with the options mentioned above,
this will provide the following options:

Open record: User can open the record form right from the map and can
further edit the details for the record.

Actions: User can perform the following actions on the pushpin selected:

Add Task: This option helps the user to create a new task in Dynamics
CRM regarding the selected record.

Schedule Appointment: The user can use this option to create a new
appointment for the selected record.

Manage Territory: The user can assign/re-assign a territory to the
selected record from the map and hence can manage the territory.

O swiz Gouapurrcs

Open Record
Directions >
Add To Route

Set As Cumrent
Location

Set As POl Location

Actions >
Save Settings >
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Census data Visualization

This feature helps the user to visualize census data on the map. Census data provides the information
about the population for a whole country or parts of country. Visualization of this data on Maplytics will
help the user to analyze various information of the required area in a country like Housing units, Area
land, Area water, population demographics, etc. and take strategic decisions. A few census data are
available by default within Maplytics. These default census data are provided by Bing maps for USA. User
can also plot their own shape files on the map which contains census data.

To plot the census data, user can choose the option of shape files in the feature of Overlay. Please refer
to the section of ‘Overlay’.

Cluster map
Search Option it
By Location CANADA s
Current Location

Claibourne, OH

Proximity

f ® Distance Time

Miles

e
PORTUGAL

Select Datasource }

2acific woroccol,

Account ¥ | | Active Accounts ¥ Dcean

+

Select Category *en

Sargasso Sea Atlantic
Ocean

ALGERIA "{

LigvA

MEXICO

Select Categ ¥

Census data - Sta... X Select Attribut ¥

Coral
Seo

b Bing [ View Data

500 miles 100!

82018 HERE. © 2018 Microsoft Corporation Terms.)

Configuration for Census data
User can configure the Census data provided by Maplytics in the Dynamics CRM. Please refer to the
section of Configure in Installation manual for the steps to ‘configure’.

While configuring the census data into Dynamics CRM, territories will get created within which the
respective census data will be saved in the form of geographies. To view the saved census data, Go to
Settings > Business Management > Sales Territories. Following are the territories for census data created
on configuration:

e Census data - States in USA

e Census data - Counties in USA

e Census data - 111th Congressional Districts in USA
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Configuration for attributes

User can configure the attributes available in the census data/shape files to show on the map, create
categories for attributes and select the colors to visualize the categorized data on the map. This allows
the user to frame the data how they want to view on the map.

Go to Settings > Business Management > Sales Territories > Territories with census data/shape files
saved > Configuration

e Attribute Configuration:

o Summary Attributes:
User can select the attributes to show on the Summary card shown on the click on the
regions in the census data/shape file plotted on the map.

o Hover Attributes:
User can select at a maximum of 6 attributes that will be shown on the hover on the
regions in the census data/shape file plotted on the map.

o Data grid Attributes:
User can select the attributes from the census data/shape file to be shown as columns in
the data grid in Detail map.

4 Attribute Configuration

Summary Attributes Actions Hover Attributes Actions Data Grid Attributes Actions

Name
Population Population

StateCode

S0 NS

Area_land

e Category Configuration
User can create categories for the attributes in the census data/shape file. Creating categories will
help the user to view the categorized census data for the required attributes in the desired colors.
Some categories are provided by default for configured census data. User can click on # new New
button to create a new category for any attribute. User can also click on # ‘Edit’ and @ ‘Remove’
to make changes or delete the existing categories respectively.

Create Categories + New

MName Actions

Population L0
Area_Land ]
Area_Water i
Pop_Overl6 i}
Pop_Male_Overlt i}
Pop_Female_Overlt i) -
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= Create filters and define colors
After clicking on Edit/New button, user can filter the attributes and define colors for the
ranges of the filtered attributes.
o Attribute: This shows the name of the Attribute for which the category has been
created/will be created.
o Display Name: User can type a name for the category which should be displayed in the
list of the categories.
o Save: User can click on save button to save the changes made.
o Discard: User can click on Discard button to discard the changes made.
o Filter: User can set various filter conditions for the category.
o Value: User can set values for respective filters set.
o Color: This can be used to set colors for individual filters set. The user can click on the
>4 Auto Set button to set random colors for all the values.
o Add/Remove: Click on Add or Remove to add a new filter or delete the filter respectively.
Attribute |Pop_FemaIe_D\.rer'IG | Display Name |P3p_FemaIe_Over16 | H 2= X%
Attribute Filter Value Color Add Remove

Pop_Female_Over... | Is Less Than v |3C'UDDUO | - + x
Pop_Female_Over... | |s Between v |3(}[]D[J[]O
Pop_Female Over... | ls Greater Than ¥ |50'UDDUO | Iﬂ'hd“ + x

| - [s000000 | - + x

After the user has created categories, user can plot the census data along with an attribute selected to
visualise the categorised Census data on the map as shown below:

R

TS
COLUMBIA EElEEil ONTARIO.

Gulfof st
= Lowrence
AT, (NOTHDRO ) v Sriere
¥ SelectAll . AN @
S Census data - States in USA LR =
RS el T |
@ <10000000 [ ] J X 2 @
: i R i -
@ >20000000 : G A 2 5!
@ 10000000 - 20000000 ]
» A, CALIFORNIA
Plot Records
Sargosso Sea
o
Gulf of Mexico.
Havana
MEXICO - oo Teun
Mexico Gity George Toun
. am) S —
JAMAICA ,‘g,r&“ Bt ohns.
BELIZES it Basseterre *
o Caribbean Sea e
Hide Data HoNou 3
] oo e
census data - states in usa (52)
@ |EnfityD Y Neame Yy | StateCode Y | Population Y | Arealand Y | AreaWater Y | Pop Overl6Y | Pop_Male.. Y | Pop_Fema..y | PopOver21y | Pop_Male.. Y | Pop_Fema..Y | Pop Over6SY | Pop_Male..
@ o Alabama AL 4779736 1311724031... | 4594951242 | 3781800 1810745 1971055 3431106 1632856 1798250 657792 278506 A
@ o Alaska AK 710231 1477849359...  2454877009.. | 544208 284293 259915 491763 256540 235223 54938 26806
@ 04 Arizona Az 6302017 2042052822.. | 1027790845 4944481 2437034 2507447 4478620 2197021 2281599 881831 401695
@ 05 Arkansas AR 2915918 1347716034.. 2960200961 | 2284744 1108864 1175880 2077218 1003093 1074125 419981 182992
< b »
wi«@ 2 [s0 v itemsperpage 1-50 of 52 items
innovative logic O ™
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Shape Operations

With the help of Shape operations, users can perform Binary operations on the shapes drawn on the map.
These operations can only be performed under the Search option of ‘By Drawing’ in the Plot card and
Territory management section. Please refer to the section of Territory management for the shape

operations in Territory management.

User can open the ‘by drawing’ search option and right click on the shapes and can choose the option of

‘Shape operations’. The following five operations can be performed on the shapes:

selected shape

Difference: This highlights the shape(s) obtained by subtracting the overlapped ones from the

/

—

\ b \ Haverhi
Banbury Y .
: X MiltoRs, [
@PLOT & PO ¢® DIRECTION ¥ (4 e Sitoey L@ >’ 4 Road
— ! \ )
: N fi
a Layer Menu \ m Stoue A Felixstowe
| > \ Stéyenage | A
\ unstable = \ Bishops i olchester
@ Plot Records o L‘{“’" 1 Sm"“:m Braintree
., \ /
Aylesbury \ / /
Cluster map \ | [ Herttora / Witham Clacton-on-Sea
| / oy
#, Search Option Oxford Hemel Hempstead  Saint Alban$ w4
j‘ . \ -\ { Chelmsford @
By Drawing v a\| )
Define shapes \ High Wycombe / Watford, Loughtdn,g witwood R
Rleolelealel] | PR\ = ,
~ | Basildon
Select Datasource Maidenhead . | Southend-on-Sea
. ~Slough |
Account ¥ || Sele v @® o | gh _3 London -
Nelpury S~ “Buacknell |
Select Category Wokingham ~_ B Mediay 3
el B R rester 2 HemeBsy Muaste
Account Select Category ¥ Wokling N2 ttingbourne - Swgle Whitstable Ramsgate
Select Overlay —— NS \ —
Select Overh = Basingstoke™ . = wne,\ anterbury
Select Overlay 7 Guildford
’ o ~ Create New Record
/ 5 g Shape Operation » | Difference
/ DidgeIwe — .
/ B Direciions > Intersection Dovet
salisbury Winchester Horsham Add To Route Union estone
Set As Current Union Aggregate
Romse, = Location G :
! _J South Downs Natrnal Pork Disjunctive Union
GRE Set As POl Location Foo
thampton | | ) /
Waterlgoville South Dowrs. Save Settings > V4
 The New Forest — | Hove Rawes S—1 1, e G
New Farest Chichester Lv\'ﬂemmpwr:N = Brighton Bexhil
Femndown Portsmouth . " octhingy
fo» ognor Regis
New Miton. The Soitrt Eastoiime
“Bournemouth ™

bR

Newport Ryde

[EView Data
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o Intersection: This highlights the shape(s) where the selected shape and other shapes overlap.

Plot Records

() Cluster map

Search Option

‘ By Drawing

Define shapes

©elealea] |
Select Datasource

+

Select Category

Account | [Select Category ¥

Select Overlay

Select Overlay v

+

Lpol ¢ DIRECTION
PR o

E 3 Layer Menu
Plot Records

[ Cluster map
Search Option

By Drawing
Define shapes

Blceeiealeal |

Select Datasource

[Account v [ select View v @
+

Select Category

sk o

Select Overlay

Select Overlay v

+

Save Template
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e Union Aggregate: This performs union operation on all the shapes that are drawn on the map. If
a shape does not overlap with any other shapes, it highlights such shapes and the union of the
rest of the overlapping shapes.

£ Layer Menu
@  Plot Records
[ Cluster map
‘Search Option

By Drawing v
Define shapes

d @002 20e

Select Datasource

I [Account v/ [Select View ®
+

Select Category

4 [Account |[Select Category ¥ | \i\\

Select Overlay

Select Overlay v
+
Save Template

¢ Disjunctive union: This highlights the shapes that are not overlapped and lie in the selected shape
& the shapes that are linked with the selected shape

/

/

I @ PLOT SPoi ¢f DIRECTION
= v T

¥ i

} -3 AT N
B Layer Menu s J,--“’-ﬂlgiqt}p\/\’-—""“kmm -

Plot Records

) Cluster map
‘Search Option

[ g
Define shapes
) V@O0 ® e
. Select Datasource
e eEr—
y +
Select Category
Select Overlay

%

Save Template
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Undo — While performing operations, user can use the option of ‘Undo’ to go only one step back
into the binary operations performed

Reset — Using the option of reset, user can remove all the operations that are performed on the
shapes drawn on the map

Note:
o To perform any operation, two or more shapes should overlap.
e For Union Aggregate, there should be more than one shapes with or without overlap.
e The highlighted shapes are new shapes as resultants of the operations performed. User
can click on the highlighted shapes to view the summary card and the data in the view
data grid.

Territory Management

Territory management helps the user to create new territories and align the existing territories. User can
plot regions on map with files or by location of regions. Based on the analysis of the plotted regions, user
can use the Alignment tool to select the required regions and create new territories. Further, user can
plot the existing territories and edit them to perform proper Territory distribution.

Go to Detail map > More Options > Territory Management

FINLAND:

1 = Print

X & Download

Note: Users other than System Admin, can use Territory management only if they are given the role
of Maplytics Territory Manager
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User can use the search options to plot shape files, excel i

. . o @ PLOT
files, search by region, draw a shape or plot existing
territories on the map. There are four search options: =
e ByfFile @ Territory Management
e By Region Search Option
e By Drawing
e By Territory
By Region
By Drawing
By Territory
By File:

This helps user to plot the shape files and excel files on the map that store geographical information and
attributes of the geographic features. User can plot the following two types of files:
e Shape files: The supported file formats are .shp, .kml and .geojson

CODE: CA06
. NAME: Northwest Territories

StatPlanetCanada (13) [ Create Territory | < Reset | © Export To Excel
CODE b i NAME 4
(o] Alberta o
CA11 Saskatchewan l
CA03 Manitoba
CAOS Newfoundland & Labrador

(k) o » o lspo w | items perpage 1-13 of 13 items
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o Excel files — The supported file formats are .xlIsx, .csv

QPLOT g POl 9 DIRECTION

- E—

@  Temitory Management

Search Option
By File

Choose File | USA States.csv

Supported file type: xisx, .csv, shp, kml and .geojson

USAStates (1628)

@ | Name ¥ | color ¥ | RegionFilter ¥ | RegionType Y | Regionvalue y | searchoption Y | Teritory v

@ Chris Paraghamian #TCFCO0 UsA State Spokane County 1 Chris Paraghamian =
@ Troy Vanbrunt #6495ED Usa state Pulaski County 1 Troy Vanbrunt n
@ TonyFebles #DAAS20 usa State Corozal County 1 Tony Febles

@ Sterling Delbridge #006400 usa state Edmunds County 1 Sterling Delbridge

= R . areanaz 1iea FAmba ALk s a VO ST ,v
W@ 23 45 . ) [s0 | itemsperpage 1-50 of 1628 items

Note: The excel files should be in a predefined format so as to get supported by Territory
Management. Please refer to the section of Bulk Geographies by uploading an Excel file

By Region y
@ Temitory Management

This options helps the users to search for regions on the map Search Option
by City, State, County, Country, PostalCode, PostCode
Sector, PostCode(Outward Code), PostalCode Area.

| By Region v |

Select Region Typs

City v
Select Region

City

State

County

Country

PostalCode

PostalCode sectar

PastalCode(Cutward Code)

PostalCode Area
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| By Region

v 8

Select Region Type

| Postalcode

v

| 10301, 10302, 10303, 10304, 10305, 10306, 10307,

| Please Enter City

| Please Enter state

| usa

|
|
| &
]
|

By Drawing

This helps the user to draw a shape using the custom Drawing Tool Bar.

(o) ST

Territory Management

Search Option

By Drawing ¥

Define shapes

(#)m(o)o)l2)2) @
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E:] Road

Layer Menu

Territory Management

Search Option

‘ By Drawing

Define shapes

oeRe] ]

By Territory

This helps user to plot the existing territories on the map.

QPLOT QPO o9 DIRECTION
e

S Layer Menu

@  Territory Managem

Search Option

f By Territory

Select Territory

| 75019 France x | 75020 France x |

| 75116 France x

@inl:lul 6’”"'—"‘05“ Page 61 of 161




Maplytics™ — User Manual

Territory Alignment Tool

This tool has four options respectively as mentioned below:

e Select/Deselect: User can select
regions/shapes/territories one by one on the map

e Deselect All: User can deselect all the selected
regions/shapes/territories on the map

o Select Multiple: This is a freehand selection which helps the user to select multiple
regions/shapes/territories on the map

e Delete: User can delete the shapes/regions/geographies plotted on the map
Note: If the delete option is used on the existing territories, it will delete the selected
geographies from the existing territories.

Note: Territory Alignment can also be performed on Plot card.
o The option of ‘create new territory’ works on all enclosed shapes except Proximity circles.
e The option of ‘Move to/copy to’ works on all shapes of plotted territories.

Create new territory

User can select some of the regions/shapes and create a new territory.
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Create new territory

') Add to existing termritory
® Create new territory

| B45_UK]

Select Manager

Select Manager
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Create territory on one click

User can create territory(ies) with a single click on ‘Create Territory’ button. User can plot shape files or
excel files on the map to view the shapes required as geographies and follow the steps mentioned below

to create territory(ies):

innovative logic
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By Shape file:
After plotting a shape file on the map, user can click on the ‘Create Territory’ button to create a new

territory with the plotted shapes as geographies or create the plotted shapes as geographies into a
selected existing territory.
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Create New Territory X

') Add to existing territory
® Create New Territory

Please enter the name of territory
Select Geography Name

Select Geography Name

Select Manager

Select Manager

User can provide the name for the new/existing Territory to be created and the respective names of
geographies will be fetched from the file.

By excel file:
After plotting an excel file, user can click on the ‘Create Territory’ button to create territories along with

the shapes plotted on the map as Geographies. The names of the territories and the respective
Geographies will be fetched from the excel file.
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Move to

User can select some geography(ies) of one or more territories and move it to another plotted existing
territory or create a new territory. This will remove the geographies from the original territory.
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%v £ Soiint
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8y Territory v 3 CATHERINE DE
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slEnd & 52 " 2 Copt/Heath
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arlswoo é
-, s
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2y X =
84091 Umbersladt
Wood End TER e
2
Rushock o
~Bromsgrove %@ 3
~ Vigo 2 Tanworth
Elmley “Tutnall H
Lovett S ? Fi Pink Gres
‘ Coskses Gieen - Aston Fields N - Beoley, ink Green ) e
& i J
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® Move to existing territory

B31_UK

© Create new territory
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Search Option

By Territory

Select Territory

| B48 UK x |

Il
Il 7
©2018 HERE, © 2018 Microsoft Corporation Terms

Copy to

User can select some geography(ies) of one or more territories and copy it to another plotted existing
territory or create a new territory while keeping the geography in the original territory.

Layer Menu

Rl Territory List
@  Termitory Managem

Search Option

By Territory |
Hoggrills End
e E

Select Territory

| B24 Uk x| B33 UK x | B34 UK x | B36 UK x |

| 836.UK x | B37_UK x | B38_UK x | B46_UK X

Q@ Piot

Bickenhill

[\

Sinutirosd
= A Four Oaks ©20
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'® Copy to existing territory
B24 UK

') Create new territory
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Shape Operations in Territory Management

User can perform Binary operations on the shapes, regions or territories plotted on the map. User can
select the shapes on which they want to perform operations and right click on them to select the Binary
operations. There are five Binary options available: Difference, Intersection, Union, Union Aggregate and
Disjunctive Union. Please refer to the section of the Shape operations to know more about these Binary
operations.

Note:
o The shapes should overlap each other to be available for performing shapes operations

e There should be a layer of drawing overlapped with the shapes to be performed binary
operations on

o The required shapes should be selected before performing Binary operations
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Multiple Territories assigned to records

If a user needs to assign more than one territory to the entity records, user can enable the feature of
Multiple Territories for a record. This feature will help the user to visualize records which lie in single or
multiple territories. After assigning the territories, they can plot the territories to visualize the respective
records lying into them.

To start using the feature of Multiple Territories for a record, user can follow the steps mentioned below:
Step 1: Enable Multiple Territories

Go to Settings > Maplytics > Maplytics Configuration Details > Default configuration detail record >
Configuration option > Select ‘Enable Multiple Territories’.

Note: User cannot undo this option, once selected and saved.

Step 2: Creating N: N relationship of entity with Territory.

Go to Settings > Customizations > Customize the System > Entities > Select Entity > N: N Relationships >
New Many-to-Many Relationship

Step 3: View the list of territories assigned to a record

Territories +
User can add a sub-grid to show the territories that an entity Wiy LS 4 Manager
record is associated with. This step is optional, even if a sub Sales 3
grid is not added, the assigned territories will get associated Services Territory

with the records in background.

Step 4: Select relationship for the field ‘Territory Relationship’ in Attribute mapping section of Entity
map.

Go to Settings > Maplytics > Entity maps > Attribute mappings > Territory Relationship > Select ‘Entity -
Territory’ relationship
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Step 5: Assign territories to records

User can either run Batch Processing tool or the Inogic.Maplytics.AssignTerritoryWorkflow on the
records to assign the territories to the records.

After assigning the territories, user can choose the Search option of ‘By territory’ to plot the territories

a

long with the respective records. The below screenshot shows a record plotted on the Detail map along

with the two overlapping territories which are assigned to the same record.

@,

Layer Menu

Plot Records

[J Cluster map
Search Option

| By Territory

Select Territory

?::Sales 3

|Services Territory

Select Datasource

| Accoun v | ’AII Accounts ¥ ‘ @

+
Select Category

| Account || Select Catey ¥

Select Overlay

| Select Overlay
+

Save Tempiate
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Detail Map on CRM Dashboard

To include the Maplytics Detail Map component on the Dashboard, click on the ‘new’ button and select
‘Add Web Resource’. Select ‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The User can
further modify this web resource by including some custom parameter. For Example, if the user wants to
plot a route from a dashboard like Appointment Planner. The user can automate the complete process.

Add Web Resource 7 x

Add an existing web resource to the Form.

General Formatting Dependencies

— Web resource

Web resource * 2‘] kI_/Maplytics/Maplytics.DetallMap.htm .ﬂ

— Field Name and Properties
MName * WebResource_ |Route

Label * Route

Display label on the Form

— Visibility

#| visible by default

—Web Resource Properties

Appointment Planner|| Dashbeard|ftrue

Custom Parameter{data)

Restrict cross-frame scripting, where supported
Pass record object-type code and unique identifier as parameters

td Enable for tablet

OK Cancel

Custom Parameter(data) : You need to provide the Custom Parameter(data) as
e <Dashboard Name>| |dashboard| |true
e Appointment Planner| |dashboard| |true
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Saved Template Visualization on CRM Entity Form

Users can include the Maplytics Detail Map component that loads a saved template associated with the
Entity record on the Entity Form. For this, the user needs to create a ‘Template’ lookup field on the Entity
form where user can select the required Maplytics Template. The user also needs to select the name of
that field in the ‘Template’ field under ‘Define Attributes’ section on the Entity Map for that particular
entity.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration  Advance Settings  Related

Title * Contextual Search Tax Exempt Numb|
| Account Name |

Template

| Land Area |

On the Entity form, the user needs to ‘Insert’ a new Tab and select ‘Add Web Resource’. Select
‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The user now needs to add a Custom
Parameter for the saved templates.

e Custom Parameter (data): Provide the Custom Parameter(data) as savetemplate

Web Resource Properties ? x

Muodify this Web resource’s properties.

Ganeral Formatting Dependencies

— Visibility

) Visibe by default

[~ Web Resource Properties

savetamplata

Custom Parameter{data)
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Now, when the user selects a Maplytics Saved Template on the ‘Template’ lookup field on the Entity form,
the selected template will be plotted on the Detail Map component added on the Entity form.

©

° A. HANSA PERSAUD & SONS

Summary Map Project Price Lists  Details  Field Service  Scheduling Related

Ticker Symbol

Relationship Type

Product Price List

Template I}

. Land Area

No. of Employees

ACCOUNT
A. HANSA PERSAUD & SONS $366,466.00 - M

Summary Tab Map Project Price Lists Details Field Service  Scheduling Related

50 fest 20m

©2019 HERE, © 2019 Microsoft Corporation Terms
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Point of Interest (POI) Locations

Ability to search for any points of interest (POI) like ATMs, restaurants, hotels, coffee shops, etc. in the
vicinity. This will be plotted alongside the CRM data.
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Apart from plotting POI data, Maplytics also allows the user to add millions of businesses in Dynamics

CRM record as lead, account, contact, or any custom-built entity by using the Create New Record option
in the POI card or Contextual menu. (Refer to Contextual menu section)
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Routing Management

User can select some locations on the map as waypoints to plot an optimized route. User can follow this
route to visit the required locations and complete their meetings. User can also redirect themselves for
turn-by-turn navigation in order to reach the right location on time.

Directions Card

Directions card provides the user with all the routing features. The user
can open the Directions Card directly by clicking on Directions tab.

@+ =

« Options

The Directions Card also opens up when the user adds a waypoint(s) to
the route either through the Contextual Menu, ToolTip Card or using the :
‘Add to Route’ mass action. User can select the required waypoints and =@ o

. .. . = To
the leaving/arriving time. ©
@ Add

destination
=000 ¥ Open Saved Routes
~Options Select Start Date *

2 t FINLAY STREET State:

-Q 18 at FINLAY STREET Staten Select End Date *
= @ 45 at CARTERET STREET Sta

= e 7327 at AMBOY ROAD Staten

= Q 8514 at AMBOY R

= e 85 at GOFF AVENUE Staten Is

@ Add
destination

Note: The user can add a maximum of 25 waypoints in the direction
Leave at | Arrive by function S.
1 15 AM
September 2018 >

Su Mo Tu We Th Fr Sa

16 17 18 19 20 21 22
23 24 25 26 27 28 29

« Open Saved Routes
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Once the waypoints are selected, the user can choose the mode

of transports like Driving, Walking or Transit to view the route.
. . . » 1T ons
The user can select different options to reduce the time, toll, g

highways, etc. by clicking on the Options button. Some of these

can be auto-selected using Maplytics Configuration Settings. e f = 9 @ @

The user can drag and drop the waypoints to change the order - Opiions

of route. ® Miles I Kilometres
®) Shortest Time ') Shortest Distance
#| Optimize Directi... L Avoid Highways
L Avoid Toll Roads L Traffic
) Along The Route

¢® Directions .. ) )
Optimize Direction

This can be selected from the Options. This option

e f = e @ @ will provide the users with the optimized route

direction between their waypoints keeping Origin &

T Options . . .

P Destination as fixed waypoints.
® Miles ) Kilometres
® Shortest Time ) Shortest Distance

IIL’I Optimize Diredi...l I Avoid Highways

| Avoid Toll Roads I Traffic
! Along The Route

Once the user clicks on ‘Go’ the route will be plotted and the directions will be available on the Directions
Card.
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/ Ocean  Station
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e T Y . G S. L8iils RANUNNI: 100,JUMEL e
= @ | H. JOSEPH BADINTER: 292.WI "055""‘}5 % STREET STATEN ISLAND NY USA
& z 2 BAY TERRACE OAKWOOD BEACH
=@ S. LoulS RAMUNNI: 100,JUMEL P
B . GreatKills Park
¥ = @ 145Rockiand Ave, New York, N § Cal
# H.JOSEPH BADINTER:
= @ | 1131 Manor Rd, New York, NY 1 \Woodrow Rd 292,WILSON AVENUENY ° Graat Kills
s b Harbor
Add destination i o !
NSl 0O E & Hide Data i !
e 2 Retztnd Reco...
Full Name Email Company Name Business Phone
=) E. LAWRENCE MANDARINO some_26232@inogic.com A Datum Corporation 7187024099 &
3 H. JOSEPH BADINTER some_5326@inogic.com ). WU (WOODY) CHEN 3478091832
3 S. LBUIS RAMUNNI some_27002@inogic.com A Datum Integration 7184887794
Wl < @ > i 50 v | items perpage 1-3of 3 items

User can view all the details regarding the pushpins on the route in the view data grid in the tab named
as entity_Route. for example: Contact_Route. Each waypoint on the route will be represented by a
pushpin. User can hover or click on any pushpin to view the details of the waypoint. If the waypoints are
records saved within Dynamics CRM, it will open the tooltip card on its click showing the respective data

configured for tooltip card.

If the waypoint is just a location, on a click it
will open a tooltip card showing its address

¥ 6647 Amboy Rd, New York, N...

and an icon which can be used to create a
record for the location. This includes the = DIRECTION =+ SETASCU.. =»SETASPOI...

Default origin and destination pushpin as well.

6647 Amboy Rd, New York, NY 10309

Take An Action
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- User can also choose to show or hide the layer
€ layer Menu of route from the layer card.

) » Route

o? Directions

_ P @ Contacts - Staten Island

0+ =Cled

Route Sharing « Options

Maplytics also helps the user to share a route in
different ways.

Email Route:

© ROUTE Priority Due Date
\&F Follow up 2 Normal 29-07-20196 o530 O e

General Route Activity Waypoints  Route Details  Related

Subject * Follow up 2 Timeline -+
Owner o) ,Q Sam K Enter a note... @
No records to show.
Regarding —
) ROUTE Priority Due Date
@ Follow up 2 Normal 2907201968 0530 0 @© ™
General  Route Activity Waypoints  Route Details  Related
Route WayPoints List =]
Route Paoint Route Options
A Leontine Mastropietre -
B Therese Zelenka
C Mack Buettner
D Sybil Silverman

The user can email the route to any of the Dynamics CRM records using email route option.
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Save Route:

o® Directions | Save The Route x

) Add to existing route

e 3 H e@ ® Enter the route name

| 9-Oct-2018|

« Options
Select route date *
2018-10-12
Users can also save their route plotted. The route record will
. . . . Owner
also save the information like number of waypoints, total
distance and time for the route. User can add the route to Select User
an existing route or save the route with a name & owner as m
a hew route.

? Save . .
User can also update any route directly using the update

button. User can search for route existing in the required

Sam_06 Oct 2018 duration and click on the update button besides the
10/6/2018 1:56 PM required route.

Sam_08 Oct 2018_Premium Update
Leads

10/8/2018 7:08 PM

William 6 Oct 2018

10/6/2018 1:57 PM

William_08 Oct 2018_Open

Cases’

10/8/2018 7:08 PM

Clear Route:

0? Directions

The user can use the Clear Route button to clear
the route from the map. This will just clear the

route and directions card will still be opened for
further use. e Y el 9 @

« Options

Another important feature of Maplytics is Routing across multiple waypoints. All the routing features in
Maplytics can be accessed from the Directions Card.
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Merged Route and Plot View

Now, when the user plots the data and then creates a route, both the plotted data and the route will stay
on the map for an easy Route Management. This makes it easy for the user to add more waypoints to the
route without switching between Plot and Directions card.

u z

CUNY WILLOWBROOK

Qgv 9
1131 Manor Rd, New

. PEOU oy,

any

S

Plot Records

¢® Directions

~ Options

© Miles © Kilometres

® Shortest Time © Shortest Distance
¥l Optimize Directi.. ) Avoid Highways
[ Avoid Toll Roads [l Traffic

[ Along The Route

(2]
(E]
(]
(0]
(]

Add destination

@© Leavenow v
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Default Origin and Destination
User can set default origin and destination for Route management.
Go to Settings > Maplytics > Maplytics Configuration Details > Record of the user

o Maplytics

General Auto Scheduling  Related

Defaults
Map Made Road Plot Data Non Cluster
Distance Unit Mile Along The Route 500
Distance :
Optimize Direction Mo Default Location 50 Perkiomen Ave, New York, NY 10312
Live Traffic No Records Per Page In
Grid 0
Route Option Shortest Time Zoom Leve
3 Map center & user 2, Peter Ashton
Heat Map Type Boundary Maplytics Security
Template B Field Sales
S ary G .
ummary rouping City Set Az Dastination Other
Default Template B Proximity - 3 Miles Other - Set As 382 Arthur Kill Rd, New York, NY 10308 -
Destination
Set As Ongin Other
| other- set as origin 10 Venus PI, New York, NY 10312 | :

There are six options to select:
e User Mailing Address - Reads address from User mailing address
e User Other Address - Reads address from User other address
e Business unit Bill to Address - Reads address from logged in user’s Business units bill to address
e Business unit Ship to Address - Reads address from logged in user’s Business units ship to address
e None - If user do not want to set default origin/destination
e Other : It will have its own multiline textbox associated where user can enter their own address

Note: If a user uses the “Plot route” button to plot a “Route” activity record on the
Detail map, the Default origin/destination will not be set in the Direction card
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Snap waypoint

This helps the user to edit a plotted route just by dragging the route to the required point on the map.
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Drag to a location: User can drag a point on the route to a required location on the map. This will add the
location as a waypoint at the dragged point in the route. This will also update the Directions card with the
newly added waypoint.

Drag to a pushpin: User can also drag a point on the route to a pushpin plotted on the map. This will

detect the record and add the record’s location at the dragged point in the route. This will also update
the Directions card with the newly added waypoint.

) innovative logic
@il‘IDEiC

60 MAPLYTICS™

Page 81 of 161




©

Maplytics™ — User Manual
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Along the Route

This feature provides the user the ability to search the records

that fall in the defined proximity along the route. The default
value for Along the Route search can be configured in the
Maplytics Configuration record. This will find all the records
with the defined search parameter and that fallsin the entered

proximity along the route.

~ Options

& Miles

®! Shortest Time

#| Optimize Directi...

Avaoid Toll Boads

Kilometres
Shortest Distance
Awvoid Highways
Traffic

#| Along The Route

5

Miles |

Note: The user can add the value between 0 — 25. The user can also add a decimal values with a scale

of 2 for the radius.

innovative logic
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The Along the route records is also saved when the user saves the route. However, if the user has selected

will be saved for along the route search in the saved route.
If the user has plotted data on the map and opens a saved

multiple Datasources on the Plot Card, only the first Entity and View combination in the Select Datasource

The user can either click on ‘Confirm’ to clear the
plotted records and search along the route records
with the Datasource saved in the route.

Or, the user can click on ‘Cancel’ to search along the
route records with the existing plotted data, ignoring

the Datasource saved in the route.

route that has along the route parameter saved as well:

Confirm!

This action will clear the

existing search criterna.

If the user open the Directions card directly without plotting the data

or opens a saved route without the along the route parameter saved,

they have the option to select the Datasource for the Along the route
search directly on the Directions Card.

innovative logic
I
EiC

the Datasource saved in the route. Click "OK to
continue Or Click 'Cancel’ to plot the route using the

plotted records and will plot

CONFIRM CANCEL

~ Options

* Miles

# Shortest Time

Avoid Toll Roads

Optimize Direction

Kilometres
Shortest Distance

Avoid Highways

Traffic
¥ Along The Route 5 Miles
Select Datasource
Account ¥ Select Vis b
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E' Leave now ¥ “

4 Open Saved Routes

Heavy traffic 2.9 mi

1 5 10 min without

S traffic
Via Finlay St
Carteret St

= @ | 7327 at AMBOY ROAD Staten I:
= @ | 6514 at AMBOY ROAD Staten I: _ _
- @ | £ at GOFF AVENUE Staten i Route Redirect and Copy Route Links
= After plotting the route, user can use the ‘Redirect’ button
@ Add to open the ‘Navigation Links’ popup on the browser as well
destiiqlion as the Dynamics 365 App for Phones and Tablets.

The user can click on individual links for route navigation
from point A—B, B—C, and so on. User can also select the application within the User Configuration record
to navigate the route. Refer the section of ‘Maplytics Configuration Details (Personalization)’ in the
installation manual to select the application. These links will redirect the route to the app selected in the

configuration.

Redirect with Google Maps

User can view the turn-by-turn navigations on Google Maps site
on desktop and Google Maps App on Phones and Tablets. User
can also choose to view the complete route.

Note: The maximum waypoints to show the complete
route is 10 waypoints.

O iz Gonruvrcs

Navigation Links x

For turn-by-turn navigation, please use the
following links

Show Complete Route

From: 22 Depew P1, New York, NY 10309
To: 994 Arthur Kill Rd, Mew York, NY 10312

From: 994 Arthur Kill Rd, Mew York, NY 10312
To: 2830 Victory Blvd, New York, NY 10314

From: 2880 Victory Bivd, New York, NY 10314
To: 218 Rosedale Ave, New York, NY 10312
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For turn-by-turn navigation, please use the
following links

From: Current Location
To: Ismael Tadao

From: Current Location
To: Estela Gopaul

From: Current Location
To: Mathilda He

From: Current Location
To: Rachele Babaev

From: Current Location
To: Vennie Tsitiridis

Maplytics™ — User Manual

Redirect with Waze

User can view the turn-by-turn navigations on Waze site on desktop
and Waze App on Phones and Tablets. This will show the navigation
links from current location to the waypoints.

Note: The check points should be under 3000 miles from the
current location to view routes on Waze.

L5, Navigation Links b 4
For turn-by-turn navigation, please use the
following links
. . . . . . . From: South Brunswick Township, NJ

Redirection on mobiles: User can click on the route navigation To: 420 Swedeland Rd, Upper Merion I:I

buttons to redirect on the Google maps/Waze. Township, PA 19406

The user can also use the ‘Copy Links’ button to copy the links to From: 420 Swedeland Rd, Upper Merion |:|

send them as an email or save it into a note. Township, PA 19406

Note:

e By default the Links will be redirected in Google Maps.
o The links redirect on the Dynamics 365 App for Phones and Tablet works with Dynamics 365

vI.x

e For other devices and Dynamics 365 v8.2, users can use the ‘Copy Links’ button.

To: Deakyneville Rd, Townsend, DE
19734

From: Deakyneville Rd, Townsend, DE |:|

Print Route

Using the ‘Print button’, the user can print the
Directions as well as the adjoining Map. After the @ PLOT £ POI ¢? DIRECTION 11«
route is plotted, user can click on the ‘More Options

4

button to open the ‘Print’ option and click on the

Print button to print the route.

innovative logi
(o)
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® PLO g PO

Q2000

v Options

© Miles

® Shortest Time
Optimize Direction
£ Avoid Toll Roads
[ Along The Route

O Kilometres

O Shortest Distance
[ Avoid Highways
0 Traffic

= () | 26 Gilroy St, New York, NY 103 |

s@lawene |
= @ | Richmond Ave ?
= Q 145 Friendship Ln, New York, M|

® Add
destination

(© Leavenow v

« Open Saved Routes

L
4 Print

& Download
View Data
ﬂ Territory Management

Todt Hill

4

2

A y f L 5
i, Linden-Park 4
%3&1& 7

49  Heaytrfiic - 20 min 02m ING R [

min  delay |
Via Huguenot Ave, RT- e
440N - Local roads i)

Clicking on the Print button will open a new window with the map and directions
on the page which can be seen in the below screenshot:

Click on the Print Icon to print the map and route instructions.

Note:
e Routing requires a minimum of two waypoints to be provided.
e A4 size paper with landscape mode is recommended while

Download map
Using the Download map button, the user can download the map as visible on

the screen

o® DIRECTION . ¢ LB

4 Print

View Data

|8 Territory Management

T

Driving Directions:

.3 Moderate raffic
2:03  1h3smn ot matic
B min V810 L1201

31 min (18.4 mi)
from Mittierer Schiogarten, 70173
Sturigar to Otlinger StraBe 16, 73274
Nomingsn

Mirterer SchioBgarien, 70173 Stumgart

Depart Athener Strae tovard
Warschauer StraBe | Pariser Platz

Road name changes o VersandSrae
Gated ro0d.

¢? DIRECTION

Note: Download map is not supported for Internet Explorer.

innovative logic
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Auto Scheduling

Auto Scheduling helps users to plan an optimized schedule to follow on the field. The user can decide the
required set of customers to meet, the preferred date and time to cover all the meetings and the number
of working days. Auto scheduling will provide an optimized schedule which includes the routes to follow
each day based on the details entered by the user and option of creating activities for the same.

User can plot the Entity records on the map that are needed to be visited. User can open the view grid to
check the number of records plotted on the map and deselect the records that are not required.

Note: Auto Scheduling can be performed on a maximum of 100 records plotted on the map

After plotting the required records on the map, user can Go to Mass actions > Auto scheduling. This will
consider all the records that are plotted on the map and will proceed to plan a schedule.

TS, j GRANITEVILLE : 4 AR o
P c C %u“_‘% 5 o € 3 { ] ® ® & = . [ 4 | | 1]
n Layer Menu ST * ® ® ® ® 09 - ; oodio @

= {440 N
N At Y &
; ® o @ ) &
Cluster map < '~ ® @ ® @
@/ { ) ® s
Search Option S 99" &
o ; e ® € . >
5 e _ ! @ x .
~ ® \. ® ®®: () .‘? - T Staten 1sland B0y S
Current Location . ¥ e s
£ (@ ® ®
D, ) sdd
Proximity ® o ® ® ® ‘l
Distan T ® s
®e &
Mil 8 .‘
@® L
-
®
tive A t L] A
7 Z y Kaufmann "
{ o A B Hide Data Campgrounds 5 Auto g
P = Retated Reco...
Account Name Y  Main Phone Yy A 1 Cit v | Primary contact v ¢ v

o g g g
— UM Y

Note: The visibility of the option of ‘Auto scheduling’ into Mass Actions will be based on the Maplytics
Security Template assigned to the user. Please refer to the section of ‘Maplytics Security Template’.
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Auto scheduling card
User can set the preferred values to be considered while scheduling a plan.

Start date: The preferred date to start the schedule
Start Location: The starting location for every day’s route

EE Auto Scheduling

S End location: The ending location for every day’s route
T = Period: The number of days the user wants to cover the
meetings in. The meetings will be distributed among the
Start Location days selected in period on the basis of optimization of
104 Kell Ave, New York, NY 10314 routes. User can choose any one options of the following:
End Location
104 Kell Ave, New York, NY 10314 ° 1 Day
Period * e 2 Day
1 Week ¥ * 3 Day
Duration * y 4 Day
e 5Day
30 Minutes o ° 1 Week
Start Time * ° 2 Week
08 v 00 v AM v ° 3 Week
End Time * e 1 Month
05 v 00 v PM Y
Break * Duration: The time frame required for each meeting. User
= . = B e can choose any one of the following options:
_ e 5 Minutes
Break Duration * ° 10 Minutes
60 Minutes x ° 15 Minutes
Buffer Time * ° 20 Minutes
10 Minutes v e 30 Minutes
Working Days * e 45 Minutes
v ¥ @ @ @ e 60 Minutes
Su Mo Tu We Th Fr Sa e 75 Minutes
e 90 Minutes
e 120 Minutes

Start time: Starting time to start the schedule of each day. User can enter the time in 12-hour format
(hh:mm)
End time: Ending time to end the schedule of each day. User can enter the time in 12-hour format (hh:mm)

Break time: Starting time of Break during each day. User can enter the time in 12-hour format (hh:mm)

Break Duration: Duration of the break during each day. User can select any one of the following options:
e 0 Minutes
e 5 Minutes
e 10 Minutes
e 15 Minutes
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e 20 Minutes
e 30 Minutes
e 45 Minutes
e 60 Minutes
e 75 Minutes
e 90 Minutes

e 120 Minutes

Buffer time: User can add extra time to the schedule as buffer to use in unforeseen situations without
changing the schedule.

e 5 Minutes

e 10 Minutes
e 15 Minutes
e 20 Minutes
e 30 Minutes

Working days: User can select the days that will be working and should be considered in the plan of Auto
scheduling. User can select any day between Sunday, Monday, Tuesday, Wednesday, Thursday, Friday,
and Saturday. At least one day should be selected.

7

10€

e
i

Auto Scheduling

o5 Sherigar & Sons
(<)

W < (J)
ve, New York NY P
Nicolosi & Sons

o 104K o @
0 Spaeth & Sons _, O :
@ Incantalupo & Sons Panicglé& Son 104 Kell Bve, New @
% 5 Vi York, NY 10314
0 Prendamana & Sons Mok py & L A
II‘: Pellegrete & Sons A =
[F) Spencer & Sons B @ 104 Ke“kﬁ,m-—ﬂéu——_
* = York, NY 10314
Scavonne & Sons 3 ok NVIBH  spacthasons |
Q 5o e & Sons ‘ ®
@ Pellegrete & Sons o & Sons Incantalupo & Sons
Q Naso & Sons — —
p————
= ———

S o statendsland BXPYE
A [ Hide Data |

Schedule for 10:01/2018 (10)

[EUREU NSRS ]

User can click on proceed to get the optimized routes for each of the working days considering all the
values provided in the Auto Scheduling card. The waypoints of the routes will be shown in the Direction
card. Users can also view the details of the waypoints in the view data grid
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Transition bar: User can use the transition bar to view the route

planned for different days. User can either click on the arrow JD e
(.:f(,. = i

buttons to go to the previous or next day plan. They can also select
the date to go directly to the date required.

Oct v, 2018 v

lort Johnson

Su Mo Tu We Th Fr Sa

1St
1 2 3 B 5 6

7 8 S

Create Activities: User can create activities for the schedule planned. The user can create the followings:
e Appointment
e Service Activity
e Bookable Resource Booking

User can also select the option of ‘Create Route(s)’ in order to save the planned routes into ‘Route’ Activity
Entity.

Gras s ———x

Select Activity Select Activity *
Bookab ource Book
: = Appointment

Name

Subject *

e Clier
Premium clients
Start Date
18-10-01 m Start Date *
End Date * 2018-10-01
10-( [

End Date *
s 2018-10-09
Sam

Owner
Booking Status *

Sam
In Progress
Booking Type ~* Priority

olid v High

¥ Create Route(s | Create Route(s)

Note: To make the option of Bookable resource booking visible, the user needs to create a relation
between the respective Entity and Bookable Resource Bookings.
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Go To Detail Map: Using this button user can go back to the Detail map.

P

Note: All the scheduled data will be cleared, if ‘Go to Detail Map’ button will be
used

Configuration details for Auto Scheduling

e User can set the default settings for Auto Scheduling in the Maplytics Configuration Details.
Go to Settings > Maplytics > Maplytics Configuration Details > Configuration details record for
the user > Auto Scheduling

MAP COMFIGURATION DETAILS
Maplytics

General  Auto Scheduling Related

feriod 5 Day ‘Working Days
- Sun
Duration 30 Minutes

Maon =i
Start Time 9:00 AM
- Tue t
End Time 6:00 PM
i wed *
Break 1:00 PM

Thu 5
Break Duration 30 Minutes

) i Ll

Buffer Time 15 Minutes

Sat

e System admin and Maplytics admin can set the start time as the default start time for the first
activity.
Go to Settings > Maplytics > Maplytics Configuration Details > Default Configuration details
record > Auto Scheduling
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MAP CONFIGURATION DETAILS : INFORMATION

Maplytics -=

» Advance Settings

Search Options

Proxy Settings

Auto Scheduling Option

I,:'e‘f"t:., ity at start time V) I

Note:
e Auto Scheduling cannot be performed on Activity entity records

e Create Activities for Custom Entity:
o A custom entity should be linked to any OOB Entity into Entity Maps in order to
Create Activities for the Entity
o If a custom entity has its own address, the option to create Appointment and
Service Activity will not be available. The user can only create activity of Bookable

Resource Bookings
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Check-In/Check-Out

Check-In feature enables users to register their arrival and departure time for the Check Points while
navigating on field with the help of Check-in and Check-Out buttons. These buttons will help to tag the
geo-coordinates of the location while a user is visiting a meeting. This will also help the management to
track the activities of the field professionals as well as the time they have spent on every meeting.

Configuration

To get started with the feature of Check-In, the first step is to configure Maplytics. Configuration will
create the Entity Map for the Check-In entity. Please refer to the section of ‘Configure’ under the ‘Initial
Setup - Maplytics License Activation, Configuration for Entity Map, Dashboards and Census data’ within
the Installation manual.

This feature can be enabled for any OOB or custom entity within their respective Entity Maps. To enable
this, System Admin/Maplytics Admin can follow the steps mentioned below. The following screenshot

shows the entity map of Appointment for an instance.

Go to Settings > Maplytics > Entity Maps > Open Required Entity Maps Record > General Tab > Enable
Check-In > Set the value to ‘Yes’ & click on ‘Save’.

ENTITY MAP
appointment

General  Attribute Mappings  Toeltip Mapping  Category Configuration  Configuration  Advance Settings  Related

Entity Name * | Appointment | Link To ‘ Regarding
& Total Records 22
&) Geocoded Records 22 & Enable Check-In Yes
Note:

e The default value for ‘Enable Check-In’ is set to ‘No’.
e User cannot undo this option, once selected and saved.
e After enabling this feature, please wait for a while before using this.
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View Related Check-In/Check-Out records:

User can choose to view the related Check-In/Check-Out records for the plotted records (Appointments,
Accounts, etc.) using the feature of ‘Plot Related Records’. To plot related Check-In/Check-Out records,
user needs to select the relationship. To select the relationships, user can follow the steps mentioned
below. We have provided the steps for Appointments for an instance.

Go to Settings > Entity Maps > Required Entity Maps record > Configuration > Related Records
Configuration > Relationship List > Select appointment - ikl_checkinentity

User can also refer to the section of ‘Related Record Configuration’” under the Entity Maps within the
Installation manual for the same.

Note: User needs to select the respective Relationship with Check-in for every entity within their
respective entity maps for which they want to see the related Check-In/Check-Out records.

ENTITY MAFP
appointment

General  Attribute Mappings  Tooltip Mapping ~ Category Configuration — Configuration  Advance Settings  Related

Related Records Configuration View Configuration
Relationship List 7 B View List H 2% x
Relationship List Relation Schema Default Relations... ¥ Views Y| View Type Y| Calor Pushpin
pocintrent - annotation Appointment_Annotatio .
appaintment - annotat ppoiniment_Annotation ¥ Al Appointments System View -
appointment - slakpiinstance slakpiinstance_appointment P
#| Appointment Planner Dashboard Record - v
appointment - syncerror Appaintment_SyncErrors !
appointment - actioncard appeintment_actioncard ¥ My Appointments System View - r;
appeintment - queusitem Appointment_Queueltem (
o a " N ¥| Ny Completed Appointments System View -
appointment - bookableresourceboo msdyn_appointment_bookableresour )
. . #| My Draft Appointments System View i
appointment - msdyn_resourcerequir msdyn_appointment_msdyn_resource v
I «|  appointment - ikl_checkinentity iki_appaintment_jkl_checkinentity I
Check-Out

After enabling the feature, user can also enable the option of ‘Check-Out’. This way the user can first click
on the Check-In button while visiting the meeting and then can click on the Check-Out button while
completing the meeting. Here, the geo-coordinates for both the locations will be saved which will also
help the management to track the time spent on the meetings.
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In order to enable Check- Out, System
Admin/Maplytics Admin can follow the steps
mentioned below:

Go to Settings > Maplytics Configuration Details >
Default Configuration Detail Record (the one with
no user name) > Check-In tab > Set the value for
Enable Check-Out to ‘Yes’ & click on ‘Save’.

Note:

MAP CONFIGURATION DETAILS
Maplytics

General Advance Settings  Check-In  Auto Scheduling  Related

I Enable Check-Out Yes I
Default Radius 0.20
Geofencing No

e The default value for ‘Enable Check-Out’ is set to ‘No’.

e User can anytime disable this option.

e Check-Out option can only be enabled for entities for which the feature of Check-In has been

enabled.

e Check-Out can be enabled/disabled only at Organization level.
e Check-Out button will only be available for the records for which the user has checked-in.

Default Radius: Itis the distance that the System admin/Maplytics admin can set to consider the accuracy
of the Check-In/Check-Out records created by the field professionals. If the Check-In/Check-Out records
do not lie within this radius then it will be considered as invalid record and will be shown with a pushpin

with this Red Cross. For example: @

MAP CONFIGURATION DETAILS
Maplytics

General Advance Settings  Check-In

Enable Check-Out Yes
Default Radius 0.20
Geofencing No

Auto Scheduling  Related

Note: By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User

Configuration Detail record.
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Geofencing

Geofencing is creating a virtual geographical boundary of a specified Geofence radius around a record. If
Geofencing is enabled, user needs to be within this radius to successfully Check-In/Check-Out for a record.
If the user is not within this radius, the user will not be able to Check-In/Check-Out and will be shown a
message specifying that they need to be within ‘n’ Km/Mi of distance from the Check-In/Check-Out
location. This will help the management to have only valid Check-In and Check-Out records done by the
field professionals.

In order to enable Geofencing, System Admin/Maplytics Admin can follow the steps mentioned below:

Go to Settings > Maplytics Configuration Details > Default Configuration Detail Record > Check-In tab >
Geofencing > Set the value for Geofencing as ‘Yes’

MAP CONFIGURATION DETAILS
Maplytics

General  Advance Settings  Check-In  Auto Scheduling  Related

Enable Check-Out Yes
Geofencing Yes
Geofence Radius 0.20

Geofence Radius:
After enabling Geofencing, System Admin/Maplytics Admin can set the default value for Geofence radius
which will be considered while a user Checks-In or Checks-Out.

Note:
e By default, Geofencing is disabled in which case the user can Check-In/Check-out from any
location.
e By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User
configuration Details record.
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Creating Check-In/Check-Out records:

While navigating on field user can Check-In and Check-Out against any record. This can be done in the
following two ways:

e From Record Form: User can open the required record (Appointments, Accounts etc.) and click on
Check-In/Check-Out button on the ribbon.

[©] Save ~ Mark Complete O Refresh ﬁ@ Map @ Check-In X Close Appointment B3 Process 2 Convert To v > Recurrence
. Appointment: Appointment Priority
Jailf] .
Appointment for Insurance Plan B3 Norma

Appointment Tab Related

Required fl Adventure Works Electronics
Optional .

Subject *  Appointment for Insurance Plan B3
Location ——-

Regarding &1 Adventure Works Electronics

Save ~ Mark Complete O Refresh '&9 Map @ Check-Out X Close Appointment Bd Process z Convert Toe 2= Recurrence
- Appointment: Appointment Priority
il .
Appointment for Insurance Plan B3 Norma e

Appointment Tab Related

Required {2 Adventure Works Electronics
Optional -

Subject *  Appointment for Insurance Plan B3
Location —

Regarding £1 Adventure Works Electronics
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Appointment: Appointm...
Appointment for Insurance PI...

~ Mark Complete

O Refresh
& Map

¥ Close Appointment

G2 Email a Link

B! Process > B7 Process >
% ConvertTo > 2 ConvertTo >
< Recurrence < Recurrence

W Delete i Delete

Appointment: Appointm... =

Appointment for Insurance Pl...

~ Mark Complete
O Refresh

& Map

Check-In

X Close Appointment

G2 Email a Link

Appointment for Insurance Plan B3

<« = f pel &

Adventure Works Electronics P (1 Adventure Works Electronics >
Optional Optional

0 pe
Subject > Subject

Appointment for Insurance Plan B3

= = @ 2 g

Note:

e User needs to allow to read the GPS location of the device in order to Check-In/Check-Out.
o The Check-Out button will be available in the place of Check-In button after the user
Checks-in.

¥ AMC Discussion

= DIRECTION =p SETASCU.. = SETASP..

¥ AMC Discussion

= DIRECTION =p SETASCU... =p SETASP..

340 228 Ave. NE Sammamish WA 98074 USA 340 228 Ave. NE Sammamish WA 98074 USA

Subject: AMC Discussion Subject: AMC Discussion

Regarding: Trey Research Assembly Regarding: Trey Research Assembly
Priority: High
Start Time: 16-07-2019 15:10

End Time: 18-07-2019 15:10

Priority: High
Start Time: 18-07-2019 15:10

End Time: 18-07-2019 15:10
Appointment Type: Not Recurring Appointment Type: Not Recurring

Take An Action
Take An Action
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c
Appolntment Type: Not fecurin

Take An Action

(@Yl )| =D

e Through Detail Map: User can click on any plotted records (Appointments, Accounts etc.) to open
the Tooltip Card and click on the Check-In/Check-Out button.

Note: Multiple Check-In/Check-Out records can be created for any record (Appointments, Accounts, etc.)

Visualize Check-In/Check-Out records on Detail Map

To analyze the activities of field professionals, Check-In/Check-Out records can be plotted on the map
like other entity with the help of the Plot Card. User can select ‘Check-In" as the Datasource and select a
required view to visualize the records from that view.

@ Plot Records

) Cluster map
Search Option
Select View
By Location System Views

Active Check-Ins
Active Check-Outs
Check-Ins This Month
Check-Ins This Week

Current Location

Proximity Check-Outs This Month
® Distance Check-Outs This Week
Inactive Check-Ins
[J Show Travel| Inactive Check-outs

My Check-Ins This Week
My Check-Outs This Week
Today's Check-Ins
Today's Check-Outs

Check-In ¥ || Select View ¥

+

Select Datasour
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Analyze Check-In/Check-Out records
After plotting the records for Check-In and Check-Out, user can analyze the pushpins by distinguishing
between the following two kinds of pushpins:

e Valid Check-In/Check-Out: When a user Checks-In/Checks-Out within the Default Radius or

Geofence Radius, it is a valid record and will be represented by v pushpin.
Invalid Check-In/Check-Out: When a user Checks-In/Checks-Out outside the Default Radius it is

represented by @ pushpin.

Visualizing Related Records

After plotting the records for Check-in, user can also choose to view the records(Appointments, Accounts
etc.) against which the plotted check-ins and check-outs were created.

Visualizing Related Record for Check-In/Check-Out records:
After selecting the relationship, user can choose to view the related record for any Check-in and Check-

Out record plotted on the map.
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29th Ave NE

: Check-in Record
z @ Related Record

NE-46th St S NE46th St =<

NE 45th St

View Data

The related record can be visualized in the following two ways:
e By Contextual Menu: User can right click on any Check-In/Check-Out pushpin to open the

‘Contextual menu’ and click on ‘Show Related Record’. This will plot the related record for the
selected pushpin. To hide the related record, user can again right click on the same Check-
In/Check-Out pushpin to open ‘Contextual Menu’ and click on ‘Hide Related Record’.

&

@
KRIC D&l € = |
Open Record Open Record

NE 45th St

NE 44th St

37th Ave NE

Show Related Hide Related Record @
Record

Directions »>
Directions > il

Add To Route

net Add To Route

Set As Current

Set As Current L ocation

Location

Set As POl Location M Set As POI Location

Actions > Actions >

Save Settings P Save Settings P

e By Tooltip Card: User can click on the Check-In/Check-Out pushpin to open the Tooltip Card and
click on ‘Show Related Record’ from the ‘Tooltip Card Actions’. To hide the related record, user
can again click on same Check-In/Check-Out pushpin to open the Tooltip Card and click on ‘Hide

Related Record’.

) innovative logic
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X account-City Power & Light ... ¥ account-City Power & Light ...
= DIRECTION = SETASCU... =p SETASP.. = DIRECTION = SETASCU... =p SETASP..
D-16/2, Sanpada Midc Road Navi Mumbai MH ... D-16/2, Sanpada Midc Road Navi Mumbai MH ...
Name: account-City Power & Light Integration Name: account-City Power & Light Integration
Owner: Sam K Owner: Sam K
User Latitude: 4766669 User Latitude: 47 66669
User Longitude: -122.19854 User Longitude: -122.19854
Created On: 18-07-2019 11:54 Created On: 18-07-2019 11:54
account: City Power & Light Integration account: City Power & Light Integration
Take An Action Take An Action

Visualizing related Check-in/Check-Out records for plotted records (Appointments, Accounts, etc.)
After selecting the relationship for the required entity within the entity map as suggested above, user can
click on any plotted record to open the Tooltip card and click on ‘Plot related record’ to plot the related
Check-In/Check-Out records.

= DIRECTION =» SETASCU.. =» SETASP..
Select the relationship to plot related record

2624 NE University Village Strest Seattle WA . |

Take An Action [ appointment - ikl_checkinentity (ikl_appoint...

wLie (] S Tol=1E] = —
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Heat Map

Clicking on the Heat Map command button will bring up the Heat Map Screen.

Y Trantord & G S\
festfiel reenwoo
' , Cemetery ‘\\ oceec Rl
Y Kill-Van' Kl ¢ 5 \ GARDENS
& Heat Map B atecen oy il \ s .
o Awed
% S
Select Datasource < K 3 £ .
72, S § AVRIDGE PARKVILLE Rl 3 %,
Account ¥ || My Active Accounts ¥ st 3 { ] / T P g
& & Cemetery A A K Bekers <
¥ Select Measure S g?\ £ T .8 raranos &
{ & £ = MAPLETON | %
Annual Revenue ¥ b3 & A2 z
£ z MARINE PAR
Select Category 1y
Ave | Industry v r Rahwiay
Please Select Region Type
PostalCode ¥
kTre Select Display e CONEY-ISLAND
- Lower New: York Bay.
Boundary MBS s
o : aneez]
Breezy
Point
Park
&
&
&
ou
¥ £33 ‘ i Raritan Bay -
% i E |
i Perth Amboy
| t $0.00 $50,709,137.00
\ St B e e B
) VRemen RS GoA Mies  1km
1> Bing 2 2 View Data 3 £ 2017 HERE 2 2017 Microssh Corporation Terms

Select Datasource:

This option helps the user to choose the Entity and view combination to analyze the data.

Select Measure:

This helps the user to define the aggregation method to be used to color code the region. By default, it is

based on number of records (i.e. ‘By Count’). The user can change this to any other field attribute from
the drop-down. Dropdown contains the list of all numeric and currency fields.

Select Category:

This option helps the user to filter data. The user can modify the search result using selection in the
Category option.

innovative logic
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Select Region Type:

This option helps the user to define the geography level for aggregation. The user can choose any option
from the drop-down:

e City

e State

o County
e Country

e PostalCode: The smallest postcode category, such as a zip code.

e PostCode Sector: The second ‘1’ is called “Postcode Sector”. Example: CA1 1

e PostCode(Outward Code): This is called Outward Code, the part of the postcode before the single
space in the middle. Example: CAl1

e PostalCode Areas: The next largest postcode category after Postcodel that is created by
aggregating Postcodel areas.

e Territory: This option will use the Sales Territory defined in Dynamics CRM.

Note:

o The regions that were plotted using the option Post code Areas before will now be plotted by
using the option of Post code sector.
o The regions will be plotted as per the Bing maps.

The default option is to summarize the addresses by City. You can find the default settings on the
Maplytics Configuration record for the individual user as shown below:
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o Maplytics

General Advance Settings  Check-In  Auto Scheduling  Related
Optimize Direction No Default Location
Live Traffic No Navigate Within
Route Option Shortest Time Records Per Page In
Grid
B Map Center —
Zoom Level
Heat Map Type Bound
oundary & User
Summary Grouping City | Maplytics Security
Template
Default Template -
Set As Destination
Set As Origin Other

Other - Set As

Destination

Other - Set As Origin 10 Voie des Vaches, 08450 Angecourt

Select Display

Loipersdorf bei Fiirstenfeld 271, 8282 Loipersdorf bei
Firstenfeld, Austria

Waze

50

Other

Mont-devant-Sassey, Meuse, France

There are four options available to analyze data on Heat Map. Default Heat map display can be selected

using Maplytics Configuration Settings.

e Boundary: This will create Heat Map on basis of selected region type like City, Postal Code,

Country, State, Territory, etc.

T Maplewood N T Hoboken b e
ewat incroft y/ 4 4 d |
n Heat Map it Millburn Irvington Jersey City, HAEE ’
Provid o= :
sty wposencs £ o / @
72 Union™ | iiicig B 2 kl
@ SelectAll i rooKiyn Mg Vall
5 Kenilworth Upper
v 8lank Mountainsis ; Bayonne New York — Valle]
Elizabeth Bay 878 Strea
v
Others ch  Westfield Cranford il A \
hs meStaten (27 East
“ Accounting Kull Isla'r"nd CANARSIE Woodmer
Linden \278) o
v 8anking !\ Cedarhurst
! <L Inwood
v
Consulting Rahway, EEACH
- Coloriia ¢ Floyd
o V % oo
Consumer Services o f B?varr HAMMEL Atlantic Beach
i TS el
v : Avenel Carteret™ "y
Engineering Avenel A
fselin Port Reacing | e
v Financial Arthuf OINT . Park
Sewaren KIF
¥ Insurance Metuchen i Pork
& ¥
Social Service - Eords (120)
- — / 3 Raritan Bay,
. Summary Card X Ratiton Perth Arh\boy’; /
TOWﬂShip wew DIUQWILK E=
i % South Amboy
BlackWelEREE Nc’mh Brunswick
g Township Sayreville
/ Laurence
y Militown « South River Madison Park Harbor
Franklin Park-* y feansbig
@ o Keyport Sandy Hook Bay 50.00 $27,082,000.00
. ) Hazlet Port Monmouth
7 Black Horse East Brunswick » Leonardo . Atlantic 2mies  2im
vl atawan
Bing | Old Bridge b T | town H:?"’”“: Hian 52018 HERE. & 2012 Micrassh Carparation Terms

e No Boundary: This option does not consider the region type. It simply creates a Heat Map by the

density of the measure selected without geographical boundaries.

W innovative logic
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® Heat Map

Select Datasource

1
‘ Account V| ‘ Active Accounts

Select Measure

‘ Annual Revenue

Select Filter
‘ Industry
Select Display

‘ No Boundary

Industry

Summary Card

Pie chart: Users can view the data in the form of Pie charts based on the heat of the attribute
selected in the Measure and Filter. Pie charts help the users to analyze the data on the basis of
comparative data shown by the Pie charts on the map.

Column chart: Users can view the data in the form of column charts plotted on the basis of the
heat of the attribute selected in the Measure and Filter. User can easily analyze the plotted data
on the basis of the proportions shown by the respective columns.
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Hover: On hover, it shows the details of that Boundary/Pie chart/Column chart
Summary Card: The user can click on any Boundary/Pie chart/Column chart to get the
summarized information of the same.

Samenary Caed

Total Records: 567

Anrwal Revenwe Sum)
$1.596.408.321.00

No. of Employwes (Sumi: 0.00

Btarkc 1
Anral Revenue (Su=) 5000
No. of Employees (Sumi 000

Accounting |
Anmal Revense (Sum §85.282.00000
No. of Employwes (Sumy 0.00

Banking 117
Anmal Reverwe (S §60.402.730 00

7 No.of Employees (Sumi 000

Beokers |
Aneal Reveews (Sumy §345 651 000,00
No. of Employees (Sumi 000

Business Services 17
Ancasl Revenoe (Sumi §184 442 50000
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Note: If Pie chart/Column chart is selected as the Display type, the option of Territory under Region
Type will not be available.

Search:

Clicking on the ‘Search’ button will plot the addresses of all the records that were selected in the view and
has already been geocoded. Records that do not have their latitude/longitude updated in the record will
be ignored and will not be plotted on the map.

Every time the users create a heat map visualization,
a ‘Summary Card’ summarizing the aggregate
information for the complete heat map will open up.

Summary card: .

Total Records: 486

This gives the users a brief summary of the heat map Annual Revenue (Measure): $256368,260.00
they created. The measure is also summarized by Annual Revenue (Surml: $256268.260.00
default. T T

No. of Employees (Sum): 23,400.00

e Logepppeerpep oy = -
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The user can also click on any region plotted on the
map to open the summary card for that region. This
_ will also filter the data of the region in the data grid.
To differentiate between the summary cards, the

individual summary cards have the region
Annual Revenue (Measure): $10,000.00 name/number as the title.

Annual Revenue (Sum): $10,000.00 If the user has selected a field attribute in the ‘Filter’
dropdown, the summary card will further
summarize the information for the selected
category filter as well.

Total Records: 1

Mo. of Employees (Sum): 2,900.00

Export to Excel: The search results are listed by the grouping selected at the bottom of the screen and
user can further export these data points using this button as shown below;

) COUNTRY LANE Keansburg

Jstown : X Keyport Sandy Hook Bay
o i XGantey [ .
Y Port Monmouth
Black Horse East Brunswick oy B o 50.00 $66,227,773.00
0Old Bridge Matawan Ai Hide Data | Highlands
2 : el T
My Active Accounts (654) ©OExport To Excel

Account Name Address 1: City Main Phone Territory ndustry Email Created On Annual Revenue

» PostalCode: 10302, NY, Staten Island, USA (Count: 18)
4 PostalCode: 10303, NY, Staten Island, USA (Count: 21)
B | Y.ANTHONY MOREN.. | Sta
=] 0. DAMIANO GERACI ... | Sta

4092255691 North - Staten Transportation 11/4/2016 12:00 AM $420,185.00

40599969317 North - Staten Engineering douglas10430@inogic... = 11/6/2016 12:00 AM $993,938.00

This functionality adhere to CRM security roles, if the user does not have permission to ‘Export Data to
Excel’ in CRM, then he/she will not be able to export data from Maplytics.

Zoom Level of Heat Map uses personalized ‘Zoom Level’ setting for the logged in user. Also, the color scale
for the Measure will be fetched from the defined ‘Heat Map Measure Color Scale’ in the Entity Category
configuration on the Entity Map for that particular entity.

Print: Clicking on the print button will print the heat map, as shown in the screenshot below:

Print

Total: 1 page

[ B2

Destination || saveasPDF

Change...
Pages o Al

g.1-5,8,11-13

Layout Landscape -

4+ More settings

5000 $50.785.692.00

ORM=BMLOGO) ©2017 HERE.6 2017 tacrosen Coprsion

n

Note: A4 size paper with landscape mode is recommended while printing.
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Support for CDS

If user does not have Dynamics CRM, they can still use Maplytics by subscribing for the PowerApps
platform. This platform comes packaged with some base entities that includes Accounts and Contacts
along with other platform entities to provide support for it security and other infrastructure.

To use Maplytics within PowerApps, user can follow the steps mentioned below:

A. Go to admin.powerapps.com > log in using PowerApps credentials.
B. Click on ‘New environment’ > Enter the details > Create an environment

PowerApps Admin center

Frvirenments e a

Environments

NAME A~ TYPE REGION CREATED BY CREATED
Data policies
PHawk Solutions (default) (org92d7d... Default United States SYSTEM 01/16/2019
2. Dataintegration
PHawk Solutions (peterhawk01) Production United States SYSTEM 01/16/2019

Tenant

New environment
Create new environments for app and flow development and to maintain
separate databases. Learn more

Environment name

Maplytics

Region (7)

ndia (default) v

Environment type (%)

Trial v

e Click on ‘Create database’ > Select the required details > Create database

You created an environment Create a database for this environment &

Choose the currency and language your data should use.

Currency ()
Do you want to create a database? usp
(Recommended)

{é? Your environment includes access to the
Common Data Service. Create a database to
start using it. 2] nclude sample
- Collect, store, and share data.

- Use data modeling @ ey choosing Craate my dat
- Create custom forms names that ys ste (out

our model, T
- Manage security and access to data and copied across regions. Leam more

e e— sl

Language (7)

English

se, you agree Microsoft can use entity and field
c 't in the database tables) to help improve
may be stored in our diagnostic systems

e Click on ‘Navigate to other Applications’ > All apps > Powerapps > Select required environment
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PowerApps in center

Q New environment

Searc
Environments
NAME A~ TYPE REGION CREATED BY CREATED
Data policies
Maplitics (orgdc2999a0) Trial (27 days) United States Peter Hawk 03/11/2019
Data integration
PHawk Solutions (default) (arg92d7d. Default United States SYSTEM 01/16/2019
Tenant
PHawk Solutions (peterhawk01) Production United States SYSTEM 01/16/2019
PowerApps Admin center ?
u Office.com D Dynamics.com Q . New environment
|~ TYPE REGION CREATED BY CREATED
s (orgdc2999a0) Trial (27 days) United States Peter Hawk 03/11/2019
Solutions {default) (org92d7d... Default United States 01/16/2019
Solutions (peterhawk01) Production United States SYSTEM 01/16/2019
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Dynamics 365
Dynamics 365 — custom
Flow

PowerApps

Security & Compliance
Talent: Attract

Talent: Onboard
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n center

|~ TYPE REGION

s (orgdc2999a0) Trial (27 days) United States

Solutions (default) (org92d7d... Default United States

Solutions (peterhawk01) Production United States

Import Maplytics solution

mo

? R
Q . New environment
CREATED BY CREATED
Peter Hawk 03/11/2019
SYSTEM 01/16/2019
SYSTEM 01/16/2019

Click on solutions at the left navigation pane > Import > Maplytics. This will create the Maplytics

App.

PowerApps

G Home
0O Learn
B Apps
Create
BE Data ~
®  Business logic v

innavative logic
.
GicC

Build business apps, fast

Create apps that connect to your data and work across web and mobile. Learn about PowerApps

Make your own app

a
—
& 3 v
+ o
@
Canvas app from blank Model-driven app from blank Start from data
P app & Model-driven app

60 MAPLYTICS™
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PowerApps Maplytics

= e |

Open AppSource = Publish all customizations 4 Switch to classic 9 Solution checker = Al
Home C -
@ Solutions
[0 Learn Dis, Created | Version
Apps Asset Checkout
I it Chall
S nnovation Challenge
Fundraiser 3/10/2019 10.0.2
B Data

Common Data Services Default Solution
o Business logi

Default Solution
i  Solutions

e To access the Maplytics App, click on Apps at the left navigation pane > Select Maplytics App.

PowerApps ljl;p;yt\ <

= | New solution <« Import {1 Open AppSource 5 Publish all customizations CZ Switchto classic Y Solution checker v = Al
Home CallFimne
& Solutions
[ Learn Display name Created | Version
Maplytics
Create
B Data v

o® Businesslogic -

f  Solutions

PowerApps

| Createanapp *~ < Import package (preview) [ Microsoft Dynamics 365

Home
Apps in
M team
Recentapps  Shared withme  Apps | canedit  Org apps
Apps
PP Name Modified Cwner Type
Create B Msplytics fodel-drive
E Deta S

o Businesslogic -

(8  Solutions

Clicking on the Maplytics app, following Maplytics dashboard will open.
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Dynamics 365 v | Maplytics | Sales > Dashboards pr G + Y -

B Save As Nev

V SetAs Default () Refresh All

&

Home

D Recent

g a Maplytics Detail Map v

52 Pinned
My Work 4 <
| %5 Dashboards
Activities
)
»Se @
Customers -
Accounts f 3 )
A Contacts (
NORWAY i RUSSIA
j
oo
MONGOLIA i
NORTH KOREA
L AN
S KoReA
CHINA
B o =
J& A

o Activate and configure Maplytics
To access the Maplytics user needs to Activate and Configure Maplytics to start the license
and configure the basic Entity maps, Dashboards and Census data.
=  Go to Settings > License registration > Click on Activate
=  Go to Settings > License registration > Click on Configure
o Add users to Maplytics team
=  Go to Settings > Teams > Maplytics team > Add users

1. Entities of leads, Cases, Opportunity, Invoices are not available in PowerApps
2. Marketing lists are not available

3. While configuring, four Entity maps will get created for Accounts, Contacts, Appointments and
Customer Address

4. Only three dashboards will get shipped on configuration
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Access Maplytics in PowerApps
User can use the credentials of the environment to log in to PowerApps and select the Maplytics app to

©

perform Maplytics features.

Qru'n SPol o9 DIRECTION § 14

@  Plot Records

| Cluster map

Search Option
By Location

J| Current Location

Proximity

® Distance

Select Datasource

Account ¥ || Active Accounts v | @
+

Select Category

b Bing

oy o
Kilometres v taursain

Washington

Castleton

Mersimac

Brightwood

& View Data

Migland

2mies  20m

2019 Microsch Corporation Terms
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Maplytics Dashboard

The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards.

Py @
FUROPE
' s Ly
SoUTH [ SOUTH %
AUSTRALIA WA AUSTRALA WA

= i
© 2016 HERE_ Eattetar Geogaptics SO © 2016 Mcxsat Capaatian
-2 Sosddvgien,

Maplytics ships with five pre-defined Dashboards for various Sales and Service Modules for different user
roles. To set up more dashboards, please refer the ‘Installation Manual’.

Steps to add Maplytics View to Dashboard:

To include the Maplytics component in

Dashboard, click on the new button and select to }:VIEEReSOL”NCIGZrOperueS ?
add Web Resource. Select
‘ikl_/Maplytics/Maplytics.Dashboard.html’ web
resource and set the name of the Dashboard [~ Web resource
record in the custom data parameter to be passed Web resource * @1 k/Mapiytics/Maplytics.Dashboardintm S|
to the HTML web resource. T

Name * WebResource_MyFollowlpCasesByTodayByPriority

Label * My Todays Follow-up Cases By Priority

Display label on the Dashboard

— Visibility

#| visible by default

—Web Resource Properties
My Todays Follow-up Cases By Priority
Custom Parameter(data)
Restrict cross-frame scripting, where supported.

Pass record object-type code and unique identifier as parameters,
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Create a route dashboard
To plot route on a CRM dashboard follow the steps mentioned below:

1. User needs to include the Maplytics Detail Map component on the Dashboard. To do this click on
the ‘New’ button in the section of dashboard and select ‘Add Web Resource’. Select
‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource.

Go to Sales > Dashboards > Click on “New” button

Collateral Marketing Goals Tools
o Bowon Peomwe [
il

2. Choose any layout as shown below:

Choose Layout x
& hl, =

3-Column

Regular Dashboard
2-Column - 2 Calusso 3-Column

5 2 olum slar Dashboard | = At can accammada
Regular Dashb. Focused Dashb This layout can accommodate

components across three columns

3. Provide the dashboard name and click on the web resource button to add the Detail map HTML
web resource.
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= save X PROPERTIES o8 CHART = uST @ WEB RESOURCE [B] IFRAME

T . .. 000 0. 0.0 . 0. 0. 0.9,

X CLOSE TIMELINE

Dasnboard

INune: * My route

R e e w rwad)

4. Add web resource :‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource

7 RER

5. Add a parameter in Custom Parameter (data) field as <Dashboard Name>| [dashboard| [true

and click on ‘OK’

Add

Web Resource

<]

6. After saving the dashboard and user can see the route plotted on the dashboard.

innovative logic

inoGic

6@ MAPLYTICS™

Page 119 of 161




@,

Maplytics™ — User Manual

My route Dashboard v

3

‘ £
*53 FARADAY ROAD LONDON
. SW19 8PE ENGLAND

25 The Mall Road London Lond«

280 LINKS ROAD TOOTING LC

: @ | 190 STREATHAM ROAD MITCH | - | =0 \ P o PHORN T WA
- (@ | MNH4659 DALTON HOUSE 60 4 o ' o |74
MJX2476 DALTON HOUSE 60\ By 2 e N s o
o =0 ! - B Tl R . Jodial..
i i . ¥ MACHIOO0E 3 ;
i'._xf‘ T T W T T S Ok - \ m( Park wm € ‘?"'""'”’a""’""?"“"‘ e as X

Note: Only 25 waypoints can be added into the route.
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Defining Geographies for Sales Territory using Maplytics

The users can create sales territories using the native Dynamics CRM ‘Sales Territories’ feature and define
geographies for the sales territories on a map using Maplytics.

To create geographies for sales territory, go to Settings > Territories and click on ‘New’ to create a sales
territory. With Maplytics a ‘Geographies’ Entity is added on the territory. User can use this feature to
visualize and create geographies for the sales territory. To create a new geography, click on ‘Add New

Geography’.

TERRITORY
Staten Island
General | Define Geography || Territory Map Preview  Related

Geographies

O Refresh

v | Name Status T

In the section ‘General’, provide a name for the Geography.

\ GEOGRAPHY
/ Postal code 10301

General Map Preview  Related

Mame " Postal code 10301

Territory © [0 Staten Island

Within the section ‘Map preview’, the user has the option to visualize the geography on a map ‘By Region’
or “By Drawing’. The ‘By Region’ option lets the user to plot the geography based on region types and the
user has the freedom to choose the color for the plotted region.

@iHnnovatnve logic 60 MAPLYTICS™ Page 121 of 161
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\‘ GEOGRAPHY
b/ Postal code 10301

£
L
y

N

General Map Preview Related

P I AT
Search Option
I By Region
Select Region Type

| Postal Code

The ‘By Drawing’ option lets the user to plot the geography by drawing a shape on the map and the user
can further edit the shape based on their needs.

GEOGRAPHY
@ Drawn shape_Staten Island

General Map Preview Related

Define Shapes

OEHOOUWE e
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Bulk Geographies by uploading an Excel file

The users also have the option to upload multiple
geographies through an Excel files supported by
CRM using the Bulk Geographies feature in
Maplytics.

X DELETE ~ = EMAILALINK | ~ EXCEL TEMPLATES ~ *._, EXPORQ TO EXCEL

Create Excel Template

ha My |mpOrtS v Create Excel Template

v | Impert Name Status Reason Successes Partial F

Create template from Dynamics... To upload the geographies in bulk, the user
first needs to export an Excel template. Go to
Settings > Data Management > Imports >
Q5] Excel Template {] Word Template select the ‘Excel Templates’ and then click on
the ‘Create Excel Template’ option.
Select data: Select the ‘Excel Template’ and in the ‘Select
Filter by entity  Geography v data’ section, select the ‘Geography’ Entity in
' , the ‘Filter by entity’ field.

Use saved view Active Geographies T

Edit Columns

Click on ‘Edit Columns’ and select the below
columns;
@ Upload Download File

Name: Name of the Geography.

Search Option: Bulk geography feature is available only for the ‘By Region’ option, so this value should
always be ‘1’

Color: Color should be in Hexadecimal format i.e. (#DAF7AB6). If the user enters the color in other format
then the default color (Blue) will be set.

Edit Columns X
Edit columns for the saved view. These columns represent the data that will be displayed in the view.
Name . color | Region Filter Region Type Region Value Search Option Territory Common Tasks
« >

FF Add Columns

FZ Change Properties

5% Remove
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County, City, PostalCode1, PostalCode2).

Region Value: If the user needs to create the geography based on Postal Code, then they can define the
postal code values in this column. To define multiple geographies in single territory, use the comma

separator (,).
Territory: This is a lookup value to define which geography belongs to which territory.

Note: For Territory management:

e The column of ‘Territory’ should contain the Names of the territory(ies)

e Color: Color should be in Hexadecimal format i.e. ( #DAF7A6). If the user enters the color in

other format then the default color (Green) will be set.

o There are 8 region types that the user can define to create the geography. (Country, State,

County, City, PostalCodel, PostalCode2, PostalCode3, PostalCode4).

Workflows

Maplytics ship the following workflows:

1.

Geocoding workflows — This geocodes addresses of the records and provides the values for
respective Latitude and Longitude.

Territory Assignment workflow — This assigns territories to CRM records on the basis of the
addresses in the respective records.

Driving Instructions workflow — This automatically generates directions (in HTML and Plain text
format) between two related entity records using their respective addresses.

Get Time zone workflow — This provides the time zone of the respective records in which they lie
based on their addresses.

Geocoding workflow is configured for Account, Lead, and Contact entities and Territory workflow for

Account by default. The user can set up these workflows for custom entities also.

+ My Processes ~
g_, MNew = L}‘E & X Q Activate 0 Deactivate More Actions =

~  Process Name Category Primary Entity Status
Inogic.Maplytics.GeoCoding Workflow Account Activated
Inogic.Maplytics.GecCoding Worldflow Contact Activated
Inogic.Maplytics.GeoCoding Workflow Lead Activated

Note: To run the workflow, please make sure the Microsoft Dynamics CRM Asynchronous
Processing service is running as shown in below screenshot.

@iI—IDEi
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File  Action Wew Help

e

Y EEEET EDE

~. Services (Local) 'Q, Services {Local)

Microsoft Dynamics CRM Hame =

Asynchronous Processing Service

Stop the service
Pause the service
Restart the service

Descripkion:
Handles the processing of queued
Asynchronous Events

L5 IP Helper

P

= Niceosnft NET Eraremork BIGER v 0 30319 Y66

Microsaft

Luboraki

it

| Description | Skatus | Startup Type | Log On As |

“CHyper-Y Data Exchange Service Providesa ... Started Automatic Local Service
“EHyper-Y Guest Shutdawn Service Provides a ... Started Automatic Local System
“CHyper-Y Heartbeat Service Monitars th...  Starbed Aukornatic Nebwark 5.
“EHyper-Y Time Synchranization Service Synchroniz...  Started Automatic Local Service
“ExHyper-y Yolume Shadow Copy Requestor Coordinate...  Started Automatic Local System
E115 Admin Service Enables thi... Started Automatic Local System
54LIKE and AuthIP IPsec Keying Modules The IKEEX...  Started Automatic Local System
5 Indexing Service Indexes co... Starked Automatic Local System
. Interactive Services Detection Enables us... Manual Local System
L Internet Connection Sharing (1C5) Provides n... Disabled Local System
L Intersite Messaging Enables me... Started Automatic Local System
Provides tu,,,  Started Automatic Local System

L IPsec Palicy Agent Internet Pr...  Started Manual Metwork 5.,
“LihKerberas Key Distribution Center on domain ... Started Automatic Local System
“EKtmRm For Distributed Transaction Coordinatar Coordinate. ., Marual Netwark 5.
i Link-Layer Topalogy Discovery Mapper Creates a .., Manual Local Service
“ExMicrosoft \NET Framework NGEM v2,0,50727_x64 Microsoft Disabled Local System
A - Microsaft ..., Disabled Local System
“CMicrosoft \NET Framework NGEM v4.0.30319_k64 Microsoft ... Automatic {D...  Local System

Local Systemn

TN Es 0o
Handes th. ..

=rarten
Started

Fati el le
Automatic

...

TIETaTE =
Network 5....

Configure Geocoding workflows for custom entities

1. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.
2. Write Process name, choose ‘Workflow’ under category section and select desired entity as

shown below;

Create Process

Define a new proce: te one from an existi
actions, dialogs, and workflows.

535, O C

Process name: * Maplytics.GeoCodingWorkflow

‘Workflow b

Run this workflow in the background (recommend

#)| Mew blank process
Mew process from an existing template (s

Account

Cance

g template. You can create four kinds of processes: business process flows,

innovative logic
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3. Select “Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields
change’ options as shown below:

rocess: Inogic.Maplytics.GeoCoding Working on solution:

P
Ig" 2. Information
Genera Administration Notes
4 Common
T, Information
[A Audit History

+ Hide Process Properties

Process Name * nogicMaplytics.GeoCoding

4 Process Sessions Entity Account

& Process Sessions

Category Workflow

Options for Automatic Processes

Scope Organizatio
As an on-demand process
Start when: Record is created
As a child process
Record status changes

Workflow Job Retention

Record is assigned

Automatically delete completed workflow jobs (to save disk space] N ~ .
Record fields change &

Record s deeted

4. For the Record fields change option, select all of the address fields to ensure the address is
geocoded when any of the address fields is changed as shown below;

Select Fields X

Select the fields that the process will monitor for changes.

Display MName & Mame Type

Address 1: Shipping Method address1_shippingmethod... Option Set =

ss 1: ZIR/Postal Code

address1_postalcode

address2_composite

#  Address 1: State/Province address1_statecrprovince Single Line of Text
#| Address 1: Street 1 addressi_linel Single Line of Text
#| Address 1: Street 2 addressi_line2 Single Line of Text
#  Address 1: Street 3 address1_line3 Single Line of Text
Address 1: Telephone 2 address1_telephone? Single Line of Text
Address 1: Telephone 3 address1_telephone3 Single Line of Text
Address 1: UPS Zone address1_upszone Single Line of Text
Address 1: UTC Offset address1_utcoffset Whale Nurnber

Single Line of Text
Multiple Lines of Text

O Cance

Note: Please don’t select Latitude & Longitude field attribute here.

W innovative logic
@il‘IDEiC
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5. Select the Inogic.Maplytics.Geocoding workflow assembly from the Add step menu as shown
below;

Process: Incgic.Maplytics.GeoCoding Working on solution: Default Solution

Lg-‘ %, Information

General | Administration  Notes
4 Common
Z. Information
& Audit History
Tt ~ Check condition for Geocode Record
[E] Process Sessions It
Account:Geocode Record does not contain data
AND

{Account:Address 1: Street 1 contains data OR Account:Adaress 1: City contains data OR AccountAddress 1: State/Province contains data OR AccountAddress 1: ZIP/Postal Code contains dats OR Account:Address 1: Street
2 contains data OR AccountAddress 1: County contains data OR AccountAddress T: Country/Region contains data), then:
& Setaddress input parameter to calculate the geocode.
Inogic.Maplytics. Geocoding (5.4.0.5:GeoCodeWorkilow.GeoCodeAddress View properties
& Set calculated Latitude and Longitude in selected record.
Update: Account View properties
Otnenwise, if
Account:Geocode Recerd equals [No)
AND
{Account:Address 1: Street 1 contains data OR Account:Address 1: Street 2 contains data OR AccountiAddress 1: City contains data OR AccountAddress 1: State/Province contains data OR AccountAddress 1: County
contains data OR AccountAddress 1: Country/Region contains data OR AccountAddress 1: ZIP/Postal Code contsins dats], then:
® Setaddress input parameter to calculate the geocode.
Inogic.Maplytics.Geocoding (5.4.0.5:GeoCodeWorkfiow.GeoCoteAddress View properties
# Setcalculated Latitude and Longitude when Geocode Record is equal to No.

Update: Account View properties

Status: Activated

Note: For custom workflows, add an 'AND' condition, if the address fields are not blank as shown in the
above screenshot. This will avoid the trigger of the workflow if the address fields do not have any value.

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the
workflow assembly;

h 2 save and Close
Process: Inogic.Maplytics.Geocoding

Ll Set Custom Step Input Properties

Property Mame Data Type Value

Street1 Single Line of Text {Bill To Street 1{lnvoice]}
Street2 Single Line of Text {Bill To Street 2{Invoice]}
Street3 Single Line of Text {Bill To Street 3{Invoice]}

City single Line of Text {Bill To Cityilnvoicel}
StateOrProvince Single Line of Text {Bill To State/Province(lnvoice]}
County Single Line of Text

Country Single Line of Text {Bill To Country/Region|lnvoice]}
PostalCode Single Line of Text {Bill To Street 3{Invoice]}

O.h:::é-'é 60 MAPLYTICS™ Page 127 of 161




Maplytics™ — User Manual

7. Choose ‘Update Record’ from ‘Add Step’ menu after selecting ‘Set Properties’ record and select
same entity for which workflow is being created.
8. Click on ‘Set Properties’ of the new record and in the update window set the Latitude, Longitude
and Rating to the output parameters returned by the workflow assembly as shown in the

screenshot below;

Geocoding Confidence Rating:

Latitude

Longitude

{Latitude{Set address il
{LongitudelSet addres:

{Rating{5et address ing

User can also check the geocoding confidence rating provided by Bing Maps. A ‘Rating’ field can be added
that shows the confidence rating as High, Medium or Low. The ‘Rating’ field is set in the workflow as

shown in the above screenshot.

Note:

<« Map

Street 1
Strest 2

Street 3

Longitude
Rating

Territory

No Auto Geocoding

No

3649 at HYLAN BLVD

10308

Staten Island

NY

usa

40.54925

-T4.13820

Medium

e Latitude and Longitude fields should of data type: ‘Floating Point Number’ with precision set to
5. Add minimum to maximum range of fields respectively Latitude (+90 to -90), Longitude (-180

to +180).

e Geocoding Confidence Rating cannot be checked for Geocoding plugin

() innovative logic
@incusié
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Configure Territory Assignment workflow for custom entities:

1. Follow the Steps 1 — 3 from configuring

geocoding workflow for custom entities.
This will help you create a new workflow.
2. For the Record fields change option, select
all of the address fields to ensure the
territory is changed when any of the Dispiay Name o Nere Type
address fields is changed as shown below; e e

Select Fields x

Select the fields that the process will monitor for changes.

ne of Text

Account Number accountnumbe Single Line of Text

Account Rating tratingcode Option Set
1

1: Address Type

Multiple Lines of Text
Option Set

=

Single Line of Text
ngle Line of Text

AN N R

wvonown U

ngle Line of Text

ng| ne of Text

Option Set

Floating Point Number

-

oK Cance!

3. Click on ‘Add Steps’ and add ‘AssignTerritoryWorkflow.AssignTerritory’ assembly as shown
below;

Process: Inogic.Territory.Assignment.workflow Working on solution: Default Solution

Li'.l Z, Information

Geners Administration Maotes

4 Common
Z. Information + Hide Process Properties
@ Audit History
o ame * Inogic.Territory Assignment Workflow . Contac
4 Process Sessions Process Name & Entity Contact

[&] Process Sessions At Process A

Category Waorkflow
Available to Run Options for Automatic Processes
Run this workflow in the background {recommended) Scope Organization v
¥ Asan on-demand process
Star when: ¥ Record is created
As a child process
Record status changes

Workflow Job Retention Record is assigned

¥ Automatically delete completed workflow jobs (to save disk space]
’ ! g pecel ¥ Record fields change

Record is deleted

E3Add Step » | JSInsert = X Destet
Assign Record -
Send Email
Start Child Workflow
Perform Action
Change Status

Stop Workflow

VaC >
Inogic.Maplytics.AssignTerritoryWorkflow (1... » -
Status: Draft Inogic.Maplytics.Geocoding (5.4.04) 3 AssignTerritoryWorkflow.AssignTerritory
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4. Click on ‘Set Properties’ and set the address parameter as shown below and Save this;

" Set Custom Step Input Properties - Microsoft Dynamics 365 - Google Chrome = B
@ https;//maplyticsdemo56.crm.dynamics.com,

I save ana Close @ He:

Process: Inogic. Territory.Assignment Workflow
E@’l Set Custom Step Input Properties

Working on solution: Default Solution

Propsrty Name Data Tyoe Required Value Form Assistant 3
Latitude Floating Point Num... Optional {Address 1 Latitude{Contact) Dynamic Values v
Dynamic Values -~
Longitude Floating Point Num... Cptional {Address 1; LatitudeiContact))
Operator:
Setto v
Look for:
Contact v
Address 1; Latitude M
X & B

Address 1: Latitude(Contact)

Default value:

Configure Get Time Zone workflow

1. Go to Settings > Processes > Click on ‘New’ to design a new Workflow Process.
2. Write Process name, choose ‘Workflow’ under category section and select desired entity:

Create Process

Define a new process, or create one from an existing template. You can create four Kinds of processes: business process flows,
actions, dialogs, and workflows.

Frocess name: * Get Timezone
Category: ™ :Wc:nrkflow ¥ Entity: * Account ¥
¥/ Run this workfiow in the background {recommended)

We recommend using Microsoft Flow instead of background workflows, Click here to start building Flows!

Type: # Mew blank process
Mew process from an existing template (select from list):

Template Mame 4 Primary Entity Owne
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Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields change’

options.

Aeyrorigtat

o
d Coremen

1
A

g &
4 Procew Semdons

:1 ¥

For the ‘Record fields Change’ option,
select all of the address fields to ensure
the address is retrieved when any of the
address fields is changed.

innovative logic

inoGic

Working on scduton |

e 40 sl it PYOFises

Select Fields

Select the fields that the process will monitor for changes.

Display Name &
hippingmethod...

Address 1: Shipping Method

tateorprovince

#  Address 1: State/Province
| Address 1: Street 1
#| Address 1: Street 2
|  Address 1: Street 3
elephone 2
Addre: elephone 3
i

6@ MAPLYTICS™

Type

Option Set

Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Whole Number
Single Line of Text
Multiple Lines of Text

Cancel

Page 131 of 161




Maplytics™ — User Manual

5. Select the Inogic.Maplytics.GetTimezone workflow assembly from the Add step menu.

» Show Process Properties

B Add Step - j‘ﬁlrser—. » A Delete this step
Microsoft.Dynamics.Service.Workflows.Contr.. »
GetMyChangedSkills 3

Microseft.Dynamics.Service.Workflows.Other  »

Estimates 3
Geofencing ]
Approvals »
Dates ]
User Praofile »

Microseft.Dynamics.Service.Workflows.Cantr...  »

Team member position accept »
Microsoft. Crm.ActionCardRankingActivity ]
Gauge »
Export Workflow ]

Microsoft.Cynamics.Marketing.Marketinglist... »

Inogic.Maplytics.GetTimezone {1.0.0.0) ] I

Inogic.Maplytics.Re at'orst‘ip[reateWort| Inogic.Maplytics.GetTimezone (1.0.0.0)

Dimmlemlnlo Plmmm emm -

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the
workflow assembly.

» Show Process Properties

B add Step - :,"Glr'ser-_v )( Delete this step.

# | 5ct the address to get the t'mezur‘d

Inogic.Maplytics.GetTimezone (1.0.0.0):nogicMaplytics.GetTimezone.GetTimezone Set Properties
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Process: Get Timezane

Property Name
Streetl
Street2
Street3
City
StateOrProvince
County
Country

Zip/PostalCode

Maplytics™ — User Manual

] Set Custom Step Input Properties

Data Type Required Value
Dynamic Values b
Single Line of Text Optional {Address 1: Street 1{Account)} ~ | Dynamic Values -
single Line of Text Optional {Address 1: Street 2{Account)} ~ Operator:
Set to A
Single Line of Text Optional Look for:
Account T
Single Line of Text Optional {address 1: City(Account)} - [Deprecated) Traversed Fath v
. . . : Add
Single Line of Text Optional {Address 1: State/Province(Acct =
X | & B
Single Line of Text Optional |
Single Line of Text Optional {Address 1: Country/RegioniAc ~
Single Line of Text Optional {Address 1: ZIP/Postal Code{Ac

‘Working on solution: Default Solution

Form Assistant

Default value:

Here, user needs to specify the address fields on the basis of which user wants to get the time zone.

After this user needs to set the time zone in field (string type). Please follow below steps for the same:

1. Choose ‘Update Record’ from ‘Add Step’ menu after selecting ‘Set Properties’ record and
select same entity for which workflow is being created.

2. Click on ‘Set Properties’ of the new record and in the update window set the TimezoneName,
TimezoneAbbreviation to the output parameters returned by the workflow assembly.

Website

Parent Account =
Ticker Symbo
Relationship Type L
one Abbreviation {TimezoneAbbreviatio
ezone {TimezoneName(Provi
Product Price List =

Once user finishes all the above steps and activates the workflow,

0 - 0 of 0 (0 selected)

user can run it on any record of the respective entity which has

address data. This will provide set the time zone set for the record

as shown below.

W innovative logic
@il‘IDEiC

summary Map Area of service

TimezoneName r

Add

X & B

TimezoneName(Provide input param

3

M 4

Default value:
f

ACCOUNT
A. DINA VEDMED & SONS

Territories

Relationship Type

Timezone Abbreviation

EST

Timezone

Eastern Standard Time

6@ MAPLYTICS™
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Configure Driving Instructions workflow
7. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.
8. Write Process name, choose ‘Workflow’ under category section and select desired entity as shown

below;

Create Process
Define a new process, or create one from an existing template. You can create four Kinds of processes: business process flows,
actions, dialogs, and workflows.,

Process name: * GetDirection

Category: * Workflow ¥ Entity: * v

¥| Run this workflow in the background (recommended) M

Tumas &) MNew blank process Account Li“

e Mew process from an existing template (select from list): Actuz

Actual Data Export (Deprecated)

Address
Agreement
Agreement Booking Date
Agreement Booking Incident
Agreement Booking Product

Template Name Primary Entity

9. Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields change’
options as shown below;

I i . Information

Crmrar e AT rrrator e
4 o
a
B iR » HEsr Pocoris Properties
2] Basir Hassny
. . |
d Procea Sembons oy
Gl Proceis Samuonm L] e Y .
C ey
Anadabeld 3 Een
b b il oasiatin P (DS
¥ B o WA RS A B Bl grdurd [T rarded
e eae
iy g o=
. AT Wi i ERmies
T2 =
- 3 CTES
e
# Lic—abcaly deele compied workl'o xer 2or
5 5 SR

Working on sclufson
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10. For the ‘Record fields Change’ option,
select all of the address fields to ensure the
address is retrieved when any of the
address fields is changed as shown below;

Select Fields

Select the fields that the process will monitor for changes.

S UNLYL YN

Display Name &
Address 1: Shipping Method
Address 1: State/Province

Address 1: S

elephone 2

elephone 3

dress1_telephone2

_telephone3

dress2_composite

Type
.. Option Set -

Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Whole Number
Single Line of Text
Multiple Lines of Text

-

OK Cancel

11. Select the Inogic.Maplytics.Drivinginstructions workflow assembly from the Add step menu as shown

below;

Genera Administration Maotes

» Show Process Properties

B Add Step ~
Stage
Check Condition
Conditional Branch
Default Action
Wait Condition
Parallel Wait Branch
Create Record
Update Record
Assign Record
Send Emai
Start Child Workflow
Perform Action
Change Status
Stop Workflow

Inogic.Maplytics. AssignTerdtoryWorkflow (1.

Irogic.Maplytics.BulkGeoGraphies {1.0.0.0)

InogicMaplytics.Geoceding (5.4.0.48)

Elnsert» X Delete this step

Inogic.Maplytics Bty [y ighe eyt (1.0.0.0)

b

Inogic.Maplytics.DrivingInstructions.Drivinglnstru... I

innovative logi
(o)
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12. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the

workflow assembly;

S1Add Step + | JSlnsert+ ¥ Delete this step

& Getthe Directions information

Inogic.Maplytics.CrivingInstructions {1.0.3.0)Inogic.Maphytics.Crivinglnstructions.DrivingInstructions § Set Properties I

Process: GetDirection Working on solution: Default Solution

(5] Set Custom Step Input Properties

Form Assistant

Property Name Data Type Required Value

Dynamic Values A
FromAddress Single Line of Text Required {Address 1: Street 1{Account)} { ¥ Dynamic Values -
ToAddress Single Line of Text Required {Address 1: Street 1{Primary Co = Operator:

Set to v
TravelMode Single Line of Text Optional Driving Look for:

Primary Contact (Contact) b
DistancelUnit Single Line of Text Optional Mile Address 1 v

Add

In ‘FromAddress’: Select the address fields of the entity that you want the direction ‘From’. Select

the all address field i.e. Steetl, Street2, and City etc. and ensure sure you keep space between
two fields.

{Address 1: Street 1(Account)} {Address 1: Street 2(Account)} {Address 1: City(Account)} {Address
1: State/Province(Account)}

In ToAddress: Select the address fields of the entity that you want the directions ‘To’. Select the
all address field i.e. Steetl, Street2, and City etc. and ensure to keep space between two fields.

Travel Mode: Select the Travel mode. For example (Driving, Walking, Transit). If you do not specify
the Travel mode then it will take Driving mode by default.

Distance Unit: Select the Distance unit. For example (Mile or mi, Kilometer or km). If you do not
specify the unit then it will take Kilometer as default unit.

13. Click on add step -> Send Email -> Click on set property

©
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PowerApps

3 B saveand Close 0 | € Acivate 3 Show Dependencies @ el ~
Process: Dire ction Working on solution: Default Solution
l;i| 2. Information
General  Administration  Notes

[ Add Step » | Sealnsert +

Stage

4 Process Sessions

[& Process Sessions

alytics. Drivinglnstructions.DrivingInstructions | Set Properties

rlies

Send Email
Start Child Wor
Perform Action

»
.. Blugins ) ¥

Portals »
Adxstudio.Xm. W ow.Identity (1. 3
Storage Utilities 3

»

InogicMapl »
Inogic.Maplytics. Drivi 3

Click on Email body -> Select Look for -> local value “inogic.Maplytics.Drivinglnstructions.
DrivingInstruction”

H Email: New Email - Microsoft Dynamics 365 - Google Chrome = =

& https://map208.crm.dynamics.com/SFA/Workflow/entityform

Il seveanc Ciose
File

Process: Dire ction
Create Email

Form Assistant >

&

W@ X (G B wereacers -

o {Account{Registration Proccess)} a
File Name (@]

&l &l

4. K- A- Q8 0 - 0 of 0 (0 selected) M4 Page

T2

Regarding

H

Duration v

Select DrivingInstruction for plan text or DrivinglnstructionHTML for html page. Click on save
and close.
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14. The driving instructions will
be returned both in HTML
and Plain Text format as an
output parameter to this
workflow. User can use
either of them. For example
we have wused HTML
formatted direction
instruction in Email here.

W innovative logic
@il‘lDEiC
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From Address: 1 NW 50th Ln Ocala FL 34482 USA

Imﬁ Frostprool L 30843 USA
[Total Traved Distance: 208.45 miles

otal Travel Duration: 3 hrs 25 min

Instruction Distance
Depart NW 50th Ln toward N'W 115th Ave 10.707
Turn right onto NW 115th Ave 0613
[Turn right onto MW Highway 4648 / CR-464B 1.692
[Keep straight onto NW 110t Ave | IAFH
[Turn right ento US-27 S/ SR-500 8 11.539
[Take ramp night for 1-75 South toward Tampa 0409
At exit 328, take ramp left for Florida's Tumpike South toward Orlando / 10,912
[Turnpike i

At cxit 289, take ramp right for US-27 toward Cleremont / Taveres 70493
[Turn left onto W Main St/ CR-17 2.715
[Turn right onto 10th St N 163
Rioad name changes o US-27 ALT / SR-17 / 10th 5t § [9.455
[Turn left to stay on US-27 ALT / 5R-17 / E Main 5t 18.945
At roundabout, take 2nd exit 16.91
Bear right omo MeLeod Rd 353
Keep straight onio N Palm Ave 1.992
[Turn left onto W 151 5t j0.202
|Arrive at Frostproof, FL i
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Maplytics Batch Processing Tool

The workflows for Geocoding and Territory Assignment designed can be used on a day-to-day basis for
addresses that are changed or added occasionally. However, for bulk geocoding/territory assignment on
data, we recommend using the Batch Processing tool. This tool ensures that the bulk geocoding on records
is handled in single batch. While in the territory assignment, this tool helps to assign the respective
territories to all the selected records based on their Latitude and Longitude values.

Note: To run this tool, the user needs to make sure that machine has Microsoft .net framework 4.0
and Maplytics installed in Dynamics CRM.

To run the tool, Extract the Batch - )
) L Narme Type Compressed size
Processing tool .zip file and run the
. . . = BatchP ingTool Applicati 104 KB

BatchProcessingTool application. Frenripcessing Toe Appreston
|| BatchProcessingTool.exe XML Configuration File 1 KB
\#| Microsoft,Crm.Sdk.Prosxy.dll Application extension 38 KB
%) Microsoft.|dentityModel.dll Application extension 360 KB
%) Microsoft.Xrm.5dk.dll Application extension 146 KB

Executing Batch Processing Tool:

Connection Details:

Please enter the CRM details on this screen. The users have to enter the following details:
Deployment model: The user can select either of the options given in below screenshot
depending on their deployment.
CRM Server: Please enter the serverurl of CRM. For example, http://<servername>:<port> or
https://<orgname>.crm.dynamics.com
Organization: If the deployment model is ‘OnPremise’ then the user has to specify the
organization name. For other deployment models leave this blank.
When the user enters the server URL in case of On-Premise deployment model, the organization
list will be auto-populated with the organizations available in CRM. Select the organization for
which Maplytics is to be or already has been installed.
Username: Username of a valid CRM user. For example: mollyc@CRM166504.onmicrosoft.com
In case of On-Premise deployment model, the organization list will be auto-populated with the
organizations available in CRM. Select the organization for which Maplytics is to be or already has
been installed.

Password: Password of CRM user.
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ﬂ Maphytscs - Batch Processing Tool [2.0U0.8) -_ b4

"-; ©  Maplytics Batch Processing

sensnsnnsn

User can also use their Client Id and Client secret key to log in for their respective CRM using Application
user.

{2} Maplytics - Bateh Processing Toel (2.0.08) - *

ﬁ 9 Maplytics Batch Processing

Cancel

Choose Option: Here, the user can make selection whether they would like to run this tool for Geocoding
(Batch Geocode) or Territory Assignment. In this example, we have chosen Batch Geocode as shown
below:
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© Maplytics - Batch Processing Tool (2.0.0.8) - o

Maplytics Batch Processing

Entity Selection and Filtering:
Please find the details of the same below:
o Entity: Select the entities on which the user would like to run this tool.
e Views: Once the user selects the entity, all the views defined for this entity are populated in the
list of views. Select the required view.

© Maplytics - Batch Processing Tool (2.0.0.8) - o

f; ©  Maplytics Batch Processing

Lead v
My Open Leads W

Add

Ertity Name View Name
Account Active Accounts
Lead My Open Leads
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Results and Log Settings:
Since this is executed as a batch process in the background, enter the email address, if the users would

like the job results to be mailed to them.
© Maplytics - Batch Processing Tool (2.0.0.8) - o

Maplytics Batch Processing

f: ()]
y©

Cancel

Progress :
In this section, the user can see the progress of the geocoding process.
)] Maplytics - Batch Processing Tool (2.0.0.8) = =

f.; ©  Maplytics Batch Processing

Fetching geocode data from Bing map
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Record Summary:

Geocoding:

Maplytics™ — User Manual

Bing Status: This shows the number of the records for which the geocoding from Bing maps were

successful or failed.

CRM Status: This shows the number of the records for which the updation of geocordinates (Latitude &
Longitude) to the respective CRM records were successful or failed.

After completing the geocoding process, the user can download the results. The results will be
downloaded in CSV format. User can check the columns of CRMDescription and BingDescription in the
result to check the reason for failure of processes on the records.

@,

@
f; (7]

innovative

[gule=]c |

Maplytics - Batch Processing Tool (2.0.0.8)

Maplytics Batch Processing

(=

Records Summary
Total processed reco
Bing Status

Succeeded Failed: O

View Name

Succeeded

Active Accounts

1044

oy o e

CRM Status
Succeeded Failed: 0

Entity View Name

1044

Succeeded

Account Active Accourts

: 1044

iy o e

1044

Go to Home Download the results

6@ MAPLYTICS™
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Territory assignment:
CRM Status: This shows the number of the records for which the updation of Territories for the respective
CRM records were successful or failed.

)] Maplytics - Batch Processing Tool (2.0.0.8) = =

f; @
»®

Maplytics Batch Processing

Records Summary
Total: 2088

CRM Status

Total Align Records

Ertity View Name Succeeded
Lead My Open Leads 1088

ronsesarts | 10

Go to Home Download the results Finish

Note:

1. [If a user selects ‘All records’ for an entity, then a view for that entity cannot be selected.

2. A user cannot select an entity with a same view twice.

3. If the user adds an entity with a view and then selects ‘All Records’ for the same entity, it will
remove all the views selected for that entity with the user’s permission.

4. All of the above instructions apply for running Batch processing tool for Territory
Assignment.
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Pre-defined colors for Categories

The users now have the ability to define colors for the categories of the plotted records. To define the

color of the category attribute, the users have to follow the below steps:

e Goto Settings > Entity Maps and select the entity map of the entity for which the user needs to

define the color.

ENTITY MAP
account

General  Attribute Mappings  Tooltip Mapping  Category Configuration  Cenfiguration

Advance Settings

Related

Entity Name * ‘ Account | Link To |

B Total Records 741

B Geocoded Records 715

e Click on the plus (+) icon of the Category
Configuration subgrid to open the new Entity
Category form. Select the name of the category
attribute in the Category text box and save the form.

e The user can select only OptionSet, Two options,
Numeric, String, Lookup and Money attributes to
define category colors.

e Colors and shapes will be auto-populated, the user
can set their own preference.

e The user can click on the 2& AutoSet button to set
random colors as well as shapes for all the values, or
the user can click on he Discard button to cancel the
changes.

ENTITY CATEGORY : INFORMATION

revenue -=

» General

4« Category Mapping

Range List

Stert Range End Range

,,,,,,

) innovative logic
@il‘IDEiC

60 MAPLYTICS™

Create New Record Yes

Color

Pushpin
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Maplytics — Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can be accessed from the

‘Detail Map’ , ‘Heat Map’ and ‘Map’ button respectively.

+
W
O

8 & &

%

My Active Accounts

New

Delete
Refresh

Detail Map
Heat Map
Email a Link
Flows

Export to Excel

Open Dashboards

-1
‘ +1-695-555-3400

W Delete

Show Char + New

© My Active Accounts ~

Detail Map

Entity homepage and entity form using the

**  Heat Map

+ | Account Name T

-1

Johnson County Museum of History

Tailspin Toys

Trey Research

Il # A B C D E F G H

Main Phone T1 | Address 1: . Tl

1-555-555-0135 1 Microsoft W...

+011-1-299-555 Mississaugua

+1-674-555-016 -

+1-695-555-340 ---

317-7364655 Johnson

297-555-0192 Tokyo

+49-(0)89-0110- Munich

J K L M N o P

Primary Contact TL| Email (Primary Contact)
Isaac Lightner isaac.lightner@onemi...
Shaun Beasley

info@fineartschool net

Cat Francis Cat@cohowinery.com

Marco Tanara mtanara@tailspintoys...

Humberto Acevedo

info@treyresearch.net

Q R S T u v w X Y zZ

ABC 1-90f 9 (0 selected)
&« = ) pel “~ = r pel g Q
Mobile Tablet
Contact: Contact
Benno Kurmann “+  New [® Deactivate Email a Link W Delete Refresh
[¢ Deactivate Contact: Contact Owner
_ Cat Francis
&  Assign @ o Test Map »
& Email a Link
il Delete Summary  Map  Details  Related
() Refresh
[ CONTACT INFORMATION Timeline +
& Map
First Name © o Cat Enter a note. B = & 0
< Process
Middle Name -
¥ Follow OLDER @
Last Name *  Francis
o Flows e Auto-post on Cat Francis's wall - 21 de marco de 2018
03:41
_— Job Title Purchasing Manager
Contact: Created By Jamie Reding (Sample Data)
Last Name * Company Name A -1 pel
Kurmann @ Like “ Reply
Email Cat@cohowinery.com %
Job Title
& = f §e « = & » g ?
innovative logic ™
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Maplytics can also be accessed from the Dynamics 365 App for Phones and Tablets (both on Dynamics
365 v8.2 and v9.x) using a dashboard for detail map. To open Detail map; Go to Dashboard > Maplytics
Detail Map as shown below:

M #  Maplytics Detail Map & #
f‘ Maplytics Detail Map v
- Mapit M < System Dashboards
Mapl Yashboare % Maplytics Detail Map
Dashboard ¥ Maplytics Heat Map
g .- « (=
mance Dashb % Maplytics Overview Dashboard karases
~ s s
% Maplytics Service Manager Dashbo... | (— 'd') % Maplytics Sales Activity Dashboard
MY @ ¥ Maplytics Sales Performance Dashb. Laptey Sea
% New Bot Dashboard - @
% Maplytics Service Manager Dashboa st
My Dashboards ’
¥ New Bot Dashboard
RUSSIA T Pechora
s I3 Soa @
o Ll - O
i e A |
S \ NORWAY, FINEA RUSSIA
e, S o i
Nl ™ WAl S
[ \y I ~
(L\ KAZAKHSTAN ‘,‘& R
3 foc 2 MON uNiTEp  CENMARK @
pe ¢ & £ XINGDOM ) 1 L
1 N i g \ BELARUS g
+§ SN i POLAND A ” X
., |UZBEKISTA) glile Germany.” y Y\ s e . e ® /
BY, Rl -ﬁ} i K * g, W Sieda e o S . SexoLoher
gt LTI sTAN | A oy 7 FP=y § ¢ KAZAKHSTAN / gor ;
\ L~ A FRanCE 7 \ MONGOLIA
\ g G R -
b I 23 Sy CH 2 X Black s )
« = 6 pH T - « = s @ 9

Detail Map: The Detail map consists of the following components.

Plot: There are five ways to plot the data on Map, similar to the Detail Map on browser;
By Location

By Region

By Drawing

By Territory

By Template
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Proximity:
Enter the radius for the proximity search. The Proximity can be provided in either Miles or Kilometers.

= - — : s
LINCOLN : $ &
SQUARE : ¢/ )
{ ~d

QpLoT & POl 9® pIRECTION |

O Cluster map
4 Search Option

By Location

Current Location
[ 222 at 5TH AVENUE Manhattan NY @

Proximity

© Distance O Time
D Show Travel Distance
Miles

1

Select Datasource

Lead | Alleads | @
| = [P P S PR S M |
. +
| Select Category
< B a
! |iSeloclCa i
Select Overlay 2
ol
—wcCar|

8 Microsot Corporaton Tarms .1

X

AR
Urrae Akt ik

3 ERBM

-

4\8

[T
©

Nare Y ®pe Y Cwner Y SaksRosmcn Y | CraledOn Y ComponyMa.. ¥ | UneolEight.. Y Frodmzy Zone Y
a | Vi B Bunny Produsts | AwbhavGhors - New 27062010 32 12 271
a | Yostve Gizkor Ewnctrosks Nobhov Ghop . Gontcied 2T062019 32 02 T
E | Zara goesiord Rad Estirn Vabtov Ghon . New V62N X2 081
| a | Wy Awat Eloctionics Vibhay Ghom.. | Contazled 2T0H2019 32 056 '
=iy Agephirs. —= w o rin % v hemscoroage 160,01 100 hems
{ ag!nwnmummmmmomwm Terms——
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Summary Card:
Now users can also get the aggregated information for a particular closed shape on the map with Summary

Card.
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Total Records: 16

¥11,875,000.00

BRI
Redmond USA

- ! -

Account - (All Accounts): 16
Annual Revenue (Average)

No. of Employees (Sum): 190.00

Madison

@ Layer Menu
B - cwamu w
a Plot Records X

M % | seattle USA

IR
juamish

Puget Sound

Bainbridge
Total Records: 16 Island:
Account - (All Accounts): 16
Annual Revenue (Average):
%11,875,000.00 &
No. of Employees (Sum): 190.00 d M
= 0
- AR 1 Shorewood ]
P A "
Normandy Park
e ‘ {Wiana:
l ¥ x Vo
All Accounts (16)
Account Name Y  Main Phone Y | Address 1: City
% City Power & Light As... = 425-555-7824 Seattle
3 Contoso Pharma Ass 206-555-5131 Seattle
% Fabrikam West 206-555-4078 Seattle
(e I 50 v items per page

- S—
Lynnwood:
Edmonds Q k3
Kingston Mountlak
@pLor | &pol 9 DIRECTION L3 el P . ¥ Road
Port Richmond

Shoreline }{;ghlands

@
A

L

Ny

Y | Primary Contact Y | Email v Status Y
Darren Parker darren.parker@wood...  Active
Cheri Castaneda cheri_castaneda@fab... ~ Active
Cheri Castaneda cheri_castaneda@fab... |~ Active

Bothelll322/

Sammamish

Mercer,
Island;

Mountain
State Forest

Coyirgton

: 4

1-16 of 16 items

Search POI:

Ability to search for any Points of Interest (POI) like ATMs, restaurants, hotels, coffee shops, etc. in the
vicinity. This will be plotted alongside the CRM data.

£ Layer Menu

Plot Records

POI Location

Nearby

| ®
=E Restaurants

ler
1> Bing

101 E Anderson St, Elma, W

(=JeJalie]g]

_/-

-i' 3_7;_, l%
o

)

)("’

2500 feet Thm

2019 HERE. © 2016 Wicrosoht Corporation Tems,

m—
% Garden Wl R4 € X m
T %
e ¥
@ pLot 9% DIRECTION |/ W S \ * ¥ Road
g 2 2
Hertage Dr 4
aLayer Menu z 3 S
z 5
— s naig & %
0 T L @
POI Location
106 W Young St, Elma, WA 98541 @
o Epinest o
Nearby - L i 3 . @\;
Q0OH0O® L % o
T P s o= o) M
% = = W Martin St i z
Restaurants b4 # z @ o
% oung St
% 5§ F g O e 2
st e S N v
_ T S I o0 ..’
| i © e
I » W.Main St w3 &
JMRTR 1 37 wwews 5% E
Wwakdip St < 1 N 2
= = W Eston S 2
g pa
3 -
P 03 @
X Maon *
= £ 2
5 £ e
: %
== WVance Creek/Park f
z g
. ‘ Wenzel Slough®d 5
. e _ 1000 feet 250m
bEing==¢) 2013 Hene, 7018 Mirusot Coporaton Toms
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: [ X]
2 e
o 2 B ] Garden Hll Rd £ % >} B4 Road
PLOT POI DIRECTION © L
1 2 H §
wosom, & § 3
£ Layer Menu Xe—% ¥ % 3
4 Hertage DF 3 k4 i
z 5
n i o ] A g
H v atg ¢ & s :
- ;, E H
Y  Joseppi's Pizzeria & Ice Cr... 3 3 oskory 2 ot
= DIRECTION = SETASCUR.. =» SETASPOI... @
i Y
QR EUHE TR S CUREL 220 Young St Grays Harbor Washington 9854... @
o SETASPOILOC.. 360-4825822 e st EPReSt
& & G & z
£ & £HE% x 2 w
| 220 Young st Grays Harbor Washington 96.. Take An Action el 8 F SN 2 1 = -
z = z = ek
- z £ Martin
360-4825822 o m ] @ A= :
[ : 3(CY- S 3
& Take An Action 4 Hy 5 ez z o Vi % £ Young St
g W Anderson St z
| .| Restaurants N v 2 /)
: =~ | I ; " (@80 e /
| & 3 = ° > & e
é # s WMainSt 2
T = y — = 2 % awent o D 3\
Restaurants X wwaldip St 2 1 b Sy =
N\ i & o ween® D =
- Fuller g 5 —
= - -0 3
Marion Rd &%
z
2 17 k)
3 L o
4 "5 %
L
- -~ Vi Creek Park 3
b B‘ Tmiles Tkm . /4 SnceTeekia % 1000 feet 250 m
Al B 2015 HERE 2019 Micrssoft Corperation Terms b 8ing = : SL 2018 HERE, 1 2018 Microsoft Corporation Terms

Category Filter: User can categorize the data on the basis of an attribute of the Entity

Select All

Wardsfisland,
Pai

>
-]

o ASTO

Select All
Cold )
Hot *

Warm Vi

- - -

4
Jfuceimier sauane GREENPOINT b
/ \
A
Grand St
EAST WILLIAMSEURG.
%
o 2500 %60t

@mm
a A

©2019 HERE. 2019 Microsoft Corporation Terms

8 on
Road &

@

w00,

New
Calvary
Cometery

Fresh

1xm

O
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Current Location:
This is used in combination with Proximity to specify the center point for the proximity search. By default,

this field displays the address stored in the Maplytics Personalized record of the logged in user.

Set GPS Location as the current location:
The user can also locate the GPS location of phone/tablet devices using ® button.

/irar Bhiwandi
- Miza Bhayander

.
, T Lt et

@  Plot Records
Kalyan

v
2
:
£

Vasai
/asa

Bhiwandi @ @ O cluster map Dombivii

Search Option
Ambarnath

@ By Location Thane

Current Location

%y

Kalyan

00O ® @

Dombivli

Thahe Ambarnath D-54/3, TTC Ind Turbhe D Block Road,

Sanyay G
13y G,

Proximity

i
© Distance QO Time
w Ulhas
: Ulhas Miles

A " Select Datasource @

Navi Mumbai Select Entit Select View
N Li Trombay

Panvel \\\ Navi Mumbai

\ ok
: % Select Overlay '
lumbai Parivel
Select Overlay
Matheran

Uran [=] »

Back

Nhave

Bay
Colaba Chauk

2mies skm

©2019 HERE, 2019 Mirosoft Corporation Terms

Bin: "
b Bng being [ View Data

GPS location is represented by ‘Blue’ circle on the map. It will automatically update the user’s current
location, making it easier to perform proximity (Near-Me) searches.

Note: Please ensure the following points for the GPS functionality to work:
e Provide ‘Location’ permission to Dynamics 365 App in phone / tablet device
e GPS location is turned ON of respective devices
e ‘User Content and Location’ is tuned ON in Dynamics 365 App
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Tooltip:

Every Pushpin will display the record name, address, as well as the contextual data defined in the tooltip
section of the Maplytics Configuration. The user can open the record, change owner and run workflow

using the available quick actions button.

Weehawken
Union Ci %

*

P ;7"'«% 7 4
7 £ 5
5
Qpior  &poi ¢ DIRECTION A4 (DA ¢

Layer Menu

|94 P DIRECTION = SETASCUR.. = SETASP..

{
RETICE SE TR 210 at EAST 17TH STREET Manhattan 10003
= SETASPOI.

=3

-

PG 5 :
o /30 c08 >

Business Phone: 6462138946

250 at PARK AVENUE SOUTH Manhattan 1.. ‘Topic: Electronics

Emall: ron7030@inogic.com

Businese Phiona: 212431545 " Website: wuw.inogic10407 com

Topic: Real Estale
]

Take An Action

| | cocee

.| Email: albert2246@inogic.com

Website: www.inogic5506.com

(=l

Take An Action

cOOR00 %

All Loads (250)

Name Y | Topic Y  Email Y | Raling
@ Dina acunto Real Estate joans540@inogic....  Cold
5 Lorene Huang Real Estate morrisd514@inogi... | Hot
E Shayla Ishay Beauty Products sharon4800@ino. Warm

) 13 4 5 (»)m 50 v | items per page

Quisens gy
sunmvsioe New
: O
Newtown rtery
o e e
........ N
>,
N
e GREENPOINT
o
of
e ¥ SAST WILLAMSBURG
b Fresf
%,

J :
k.
= Rt .| - M Actons

Y  Business Phone ¥Y | Website Y | Company Name Y
2129329199 WWwinogic8ese.c.
2129223565 W inogic7836.c.
2128970945 www.inogic8122.c.

51-100 of 250 items

Contextual Menu:

To get a contextual menu on the map, long press anywhere on the map. Pushpin Contextual menu
provides the following additional options. These option provides commonly used features in Maplytics

like Set as Current Location, Origin, and Adding to Route, etc.

) e
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Set As Origin:

Selecting this option will set the address of the pushpin as the start location of the route.

Set As Destination:

Selecting this option will set the address of the pushpin as the end location of the route.

Add to Route:

This option will set the address of the pushpin as a middle waypoint of the selected route. For example, if
the users already have Point A and Point B selected as their route, and click on the Add To Route option,
then the Point B will become Point C, and the address of the selected pushpin will become the Point B of
their route.

Set As Current Location:

This option is used to set the address of the pushpin as the current location, which can be used for
proximity search. For example, if the user wants to plot all the leads that are within a radius of 100 miles
from a particular record then the user can click on the Set As Current Location option to set the address
as the current location and then the user can plot the records around this location.

This option also removes the additional step to type the current location manually for the proximity
search.

Set As POI Location:

This option helps the user to set the center point for the Point of Interest (POI) searches like ATMs,
restaurants, Airports, etc. Once this location is set as the POI location, the user can search for different
POI around this location.

Manage Territory:
The user can manage the territory, i.e., assign/re-assign territory from the map using this option.

Save Template:
User can save the plotted search criteria as a template, so as to open the template directly instead of

searching on the map again.

Save The Template

Save The Template

Add to existing template
QOAddto existing template

@ Create new template

© Create new template

Please enter the template name.
Access Level Access Level

Personal v Seczoral
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Routing — Tablet / Mobile

Another essential feature of Maplytics is Routing across multiple waypoints. Using the Contextual Menu
options explained above, the users can add multiple waypoints to their journey. At given point in time,
the users can add maximum 25 waypoints in direction.

= C = TrETey g
= 7 Baym j {sland /yf"n.,, m
i : BULLS HEAD Ze EMERSON MILL
Y @por  &Bpoi  ¢%DIRECTION K4 z >
-0 L : ort Johnso - . F-i NY WILLOWEROOK 8
7 : of TodtHil 65 Emerson Ct, New
Layer Menu x * " York, NY 10304
3 s "
o~ - m——— 4
WEST NEW b
e -‘E Plot Records X waws H
| A. ®
725 Forest Av NEW SPRINGVILLE
i e R lew York, NY 10 ¥ Directions y
i CUR > 5 M oo, »
[y ~Options iE e Gimatery ;" @
| T Q= &
é = @) | 5223 Amboy Rd, New York NY 1 LTodtH | ~Options ATl EGRERTVILLE @
] / ar
= @ | 54Cherrywood Ct, New York, NY Ic) © Miles QO Kilometres LATTOURITTE PARK eNiRA el A &
- @ | Staten sland. Ny staten Island, N kf O shortestTime O Shortest Distance New York, NY 10306 . o
| United A
|= @ | 725Forest Ave, New York, NY 1C ERTVILLE N Optimize Direct. @ Avoid Highways mt(’::\:;nd Hebrew DJ""“CE" Field
= = Cemetery eig e Do sans
o (O Avoid Toll Roads () Traffic Station AT
e @ Add destination wood i GREENRIDGE SRIEIIC
c ights Fig (O Along The Route L Comuyry oAKXWOOD
ct, / 3
00D BEACH 2
~Open Saved Routes . =@ 221 AbeeAve. Naw Yox ¥ BAY THRRACE OAKWO0D HEATH
: H
= s::i = @ 13 Oakdalo St New Yorl o GreatKills Park
o™ (6] &
’ 8 = @ 24 Geldner Ave, New Y + 111113 Oakdale St, New
5223 Amboy Rd, New York, NY 10308  Great Kills
~ York,NY 10312 = @ 65Emerson Ct, New Yor v Harbor
) Add destination ¢ o
— 21 Albee Ave, New
i - York, NY 10312 (541s
@ Leave now v
—
- +Open Saved Routes
PO T— . rLamns. =
¥ PRINCE'S BAY
4 : 00t T
| | @ <4 HERE. Meroret Corperation
[ View Data © 2019 HERE. B 2010 Terms.

Once multiple waypoints have been added, click on Go button to bring up the Routing Screen shown
below.
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Merged Route and Plot View:

When the user plots the data and then creates a route, both the plotted data and the route will stay on
the map. This makes it easy for the user to add more waypoints to the route without switching between
Plot and Directions card. The route can be cleared using the ‘Clear Route’ button.
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Save Route and Plot Saved Routes:
Users can now save the route from the Dynamics 365 App for Phones and Tablets and later use the ‘Open
Saved Route’ feature to plot the saved routes.

Save The Route
Save The Route

_ Add to existing route

(© Add 1o existing route

® Create new route * © Greate new route *

Foliow up 3

Follew up route 2

Select route date * Select route date *

2019-07-22 2019-07-22
Owner
Owner
DevH
DevH
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Email route - The user can email route to any of the
Dynamics CRM records using email route option.

Along the Route Search:
The user can also search the along the route records the same way as on the Browser.
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Route Redirect and Copy Navigation Links:

Redirect with Google Maps

Navigation Links

Navigation Links
For turn-by-turn navigation, please use the

following links For turn-by-turn navigation, please use the
following links

Show Complete Route

From: Leontine Mastropietro
To: Therese Zelenka

From: Therese Zelenka
To: Mack Buettner

Froen: Gabelel
To: Khani &

From: Khani & Sons

From: Mack Buettner
To: Sybil Silverman

& Copy Links

Redirect with Waze

Navigation Links Navigation Links

For turn-by-turn navigation, please use the For turn-by-turn navigation, please use the
following links following links

From: Current Location From: Current Location
To: Leontine Mastropietro To: Gabriel & Sons

From: Current Location
To: Khani & Sons

From: Current Location
To: Therese Zelenka

From: Cumrent Location

From: Current Location To: Halabian & Sons

To: Mack Buettner

From: Current Location
From: Current Location To: Mohammad & Sons
To: Sybil Silverman

& Copy Links
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Heat Map — Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can also from the Entity homepage and entity form using ‘Heat Map’.
When clicked on Heat Map button, it opens the heat map.

Summary card:

10305

Total Records: 33
€ sales (Measure):
. $4,700,148.00
Annual Revenue
= (Average): $319,813.76
~ Opportunity Pipeline
| (average):
$336,976.9167
Number of Employees
= (Average): 52

Banking: 15
Sales (Measure):
" $115,250.00
|& Annual Revenue
~ (Average): $331,666.57
; Opportunity Pipeline
(Average):
$342,380.8571
Number of Employees
" (Average): 58

| Engineering: 6
Sales (Measure):

B Industry X
e ;
Summary Card X!

% Total Records: 3

1" (Measure): $4,700.148

w Annual Revenue (Average):

 $319,813.76

- Opportunity Pipeline
(Average): $336,976.9167

w« Number of Employees

| (Average): 52

~ Banking: 15

(Measure): $115,250
Annual Revenue (Average):
$331,666.57

~  Opportunity Pipeline

| (Average) $342,380.8571
Number of Employees
(Average): 58

Engineering ©
(Measure): $1,502,000

~ Annual Revenue (Average):
Y §289.412.17

Opportunity Pipeline

@.n‘?&'i”&'u“."_'-‘
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Pie chart in Heat Map

Column chart in Heat Map
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Dashboards — Tablet / Mobile
The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards.

4:45PM e T Ll

© Maplytics Overvie.. v -

'ment Planner

W8y
yaendreksVEE
2 Subject:
/ 7 Regarding:
Start Time: 12/
End Time:
Ave B Appointment Type: |

AVE

0
Sefbdne

5 Corson

2, = Q 4 0 @ ¢« = ® P ] Q
Maplytics ships with 6 pre-defined Dashboards for various Sales and Service Modules for different user
roles.

@.né“s.i“: &P MAPLYTICS™ Page 160 of 161




Maplytics™ — User Manual

Contact Us

M/S. INOGIC TECH (INDIA) PVT. LTD.
A-301 Everest Nivara InfoTech Park,
MIDC, Turbhe,

Navi Mumbai - 400 705 - INDIA.

E-mail: crm@inogic.com

Twitter: @Maplytics; @Inogic

Facebook: @Maplytics; @Inogic

Website: http://www.maplytics.com/ ; http://www.inogic.com/
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